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Print Audit 6 Administration 

 

Welcome 

Welcome to the Print Audit 6 Administration tool. You use the Print Audit 6 
Administration tool to configure all aspects of Print Audit 6. 

The tool consists of several sections; each one focuses on a different aspect of 
Print Audit 6. You may not need to use all the sections in Print Audit depending 
on your business needs, but you should familiarize yourself with all of them to 
fully understand what Print Audit offers. 

Please note that you may not have access to all that Print Audit has to offer 
depending on the type of licensing you purchased. 

You can begin using Print Audit immediately with little to no configuration, but we 
recommend you read the following topics to get an idea of what the product can 
offer to your organization: 

 Pricing in Print Audit 
 Custom Rules 
 Printing Limits and Redirection 
 Allowances and Balances 
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Below are links to topics describing each section of the Administration tool: 

 System Settings - This section contains information on Administration 
settings that affect all areas of Print Audit. 

 Client - This section contains information on how to configure the Print 
Audit Client and how Print Audit tracks your print jobs. 

 Printers - This section contains information on how to manage and 
configure how Print Audit tracks your printers when printing. 

 Users - This section contains information on how to manage and 
configure how Print Audit tracks your users when printing.  

 Custom Rules - This section contains information on how to use our new 
advanced custom rules feature. 

 Applications (Advanced) - This section contains information how to 
manage and configure how Print Audit tracks printing from different 
applications. 

 Network and Authentication (Advanced) - This section contains 
information on advanced network configuration and other advanced topics 
for more complex networks. 

General 

Print Audit Licensing 

For evaluation purposes you can request a trial license. The trial lasts for 15-
days and works on up to 5 computers in your organization. Once your trial ends, 
you must purchase a license to continue using the software. 

To start a trial: 

1. When the Administration tool starts and you have no license, the License 
Activation dialog appears. 

2. Click the Request a trial license option and click the Activate button. 
The Registration window appears. 

3. Please enter information for all of the fields in the Registration window. We 
use this information so we can support you in your use of the trial. 

4. Click the Submit button. Print Audit contacts our licensing server and 
activates your trial. 
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NOTE: Once you start a trial, you cannot request another one. If you need to 
extend your trial, or have any questions about the software, please contact Print 
Audit support. 

To purchase a new license: 

1. Please contact Print Audit directly, or an authorized Print Audit dealer. 
They will take your customer information and supply you with a Print Audit 
license key along with the company name recorded for your purchase. 

To activate a license: 

1. If the License dialog does not appear when you start the Administration 
tool, go to the Tools->View/Change License menu item. The Licensing 
dialog appears. 

2. Click the Activate License button. The Activation dialog appears. 
3. Click the Activate existing license option. 
4. Enter in your customer information and license key as required. 
5. Click the Activate button. The Registration window appears. 
6. Please enter information for all of the fields in the Registration window. We 

use this information so we can support you in the use of the software. 
7. Click the Submit button. Print Audit contacts our license server and 

activates your key. 

If you do not have internet access, or your activation over the internet fails, 
please contact Print Audit so we can activate your license by other means. 

Changing Your Database   

If you have several different Print Audit databases you may need to point the 
Administration tool to one or the other. When you change databases Print Audit 
asks you for any authentication information before you can use the new 
database. 

If you do not have rights to the new database, or Print Audit encounters some 
other problem, the Administration tool continues to use your existing database 
selection. 
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To change your database: 

1. Click the Tools->Set Database menu. A dialog appears asking you to 
select your new database. 

2. Select the new database. For Access databases simply select the new 
database file. For SQL Server databases please enter the new SQL 
information. 

3. Accept the information. Print Audit attempts to log in to the new database. 

Clearing Pending Jobs 

Print Audit creates pending jobs when a user either chooses to snooze a job, or 
when the Print Audit Client sends jobs that were tracked when it was 
disconnected from the Client Communicator to the database. Only jobs that 
required pop up information from the user are stored as pending jobs. 

In some rare cases, a user could have too many pending jobs to comfortably 
enter information for. This could happen if their Client was unable to 
communicate with the Client Communicator for an extended period of time due to 
a configuration error for example. 

If you want to clear pending jobs for all users from the database, you can use the 
Clear Pending Jobs command. Only users who have the rights to edit and 
delete jobs can clear pending jobs. 

To clear pending jobs: 

1. Click the Tools->Clear Pending Jobs menu. A dialog appears asking you 
if you are sure you want to clear the pending jobs. 

2. Click the Yes button to have Print Audit clear all jobs. NOTE: Once jobs 
are cleared you cannot get them back. 

System Settings 

Overview 

This section of the Administration tool allows you to define settings that affect the 
overall operation of Print Audit 6. These settings include things such as how 
many decimal places to use for costs and reporting, as well as the email settings 
Print Audit should use when sending email. 
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Listed below are the options you can set in this section. 

General Settings 

Decimal Places for Costs - You can use from two to four decimal places for 
costs you assign to printers, users and applications. This setting applies to both 
data entry and is the default for reporting, however you can choose to override 
this setting when creating reports. 

Percentage Modifier Option - This setting affects how Print Audit handles job 
cost calculations when multiple cost percentage modifiers are encountered. Click 
here for more information on job costing in Print Audit 6. The options are as 
follows: 

 Apply Each - This option applies each percentage modifier to the cost in 
the order that it was encountered. For example, if there is a 50% modifier, 
then another 25%, the final job cost reduced by half, and then by a 
quarter. 

 Legacy - This option calculates percentage modifiers the same way as 
past versions of Print Audit. Provided for backwards compatibility only, we 
highly recommend you choose one of the other options. 

 Use Highest - This option uses only the highest modifier encountered. For 
example, if you had a 50% cost modifier and a 200% cost modifier both 
applicable for the job, only the 200% modifier is taken into account. 

 Use Lowest -This option uses only the lowest modifier encountered. For 
example, if you had a 50% cost modifier and a 200% cost modifier both 
applicable for the job, only the 50% modifier is taken into account. 

Email Notifications 

You can configure Print Audit 6 to send email for things like license violations, 
scheduled reports and in response to certain conditions using custom rules. 
Before Print Audit 6 can send emails, you must properly set the following options: 

SMTP Server - The name or IP address of the SMTP server in your organization 
to use for sending emails. 

SMTP Login - The login to use if your SMTP server requires authentication. If it 
does not, you can leave this blank. 

SMTP Password - The password to use if your SMTP server requires 
authentication. If it does not, you can leave this blank. 
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Email Address - Enter the email address of the person you want notified in case 
of licensing issues. Generally you should enter the email address of the person in 
your organization responsible for administering Print Audit. 

Send Email to Print Audit - Select "Yes" to have Print Audit send an email to 
our licensing department in case of licensing issues. Print Audit sends no private 
information, simply your licensing information and the nature of the problem. We 
use this information to then contact you and help you with your problem. 

Select "No" (the default) if you do not want to notify us of licensing issues. If 
selected, no information is sent to us. 

Client Settings 

Overview 

This section of the Administration tool allows you to set general information about 
how the Print Audit Client behaves on the desktop. It controls things such as if 
you want to allow the user to shutdown the Client, whether or not it supports 
batching and how users have to authenticate before they can print. 

 Listed below are all the options you can set in this section: 

General Settings 

This section controls in general how the Client behaves on the Windows desktop. 

 Display Tray Icon - If set to Yes a tray icon displays in the Windows task 
bar area when the Client is running. 

 Wait for Page Count (Recovery only) - If set to Yes, the Client does not 
display the Popup window until it has the page count. This can cause a 
delay before the Popup window appears. If set to No, the Client does not 
display the final job cost or final number of pages on the Popup window. 
NOTE: If you have Reduction only, this setting gets changed automatically 
when you add printer limits.  

 Shutdown the Client - If set to Yes the user can shutdown the Client. 
 Enter Comments (Recovery only) - If set to Yes the user can enter 

comments on the Popup window when it displays. 
 Use Last Entries (Recovery only) - If set to Yes Print Audit automatically 

populates the Client Popup window with the same entries they used on 
the last print job. 
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Client Logo Settings (Recovery Only)  

You can choose to set a custom logo to display on the Client popup window 
when a user prints. The logo must be 474x88 pixels. 

Batch Settings (Recovery Only) 

This section controls how the Print Audit Client controls batching. Batching is 
how Print Audit handles multiple print jobs when you want to re-use the same 
Popup Window entries as a previous job automatically. Please note that these 
settings have no effect if you configure the Client to not display a popup window 
when printing. 

Batching Type - There are three types of batching. 

 None: The Client displays a popup on every print. 
 Automatic: The Client automatically re-uses the same popup window 

entries for all jobs that you print within the batch timeout from the same 
program. 

 Manual: The Client allows you to enter the number of jobs you want to 
batch on the popup. Print Audit automatically re-uses the popup settings 
for the number of jobs you indicated or until the time-out expires. 

Maximum Batch Size - This displays only for the Manual batch type. You enter 
the maximum number of jobs you want the user to batch here. 

Batch Time-out - Use this to enter the number of seconds Print Audit waits 
before cancelling a batch. This indicates the time-out between jobs, not overall. 
For example, if you enter 60 seconds for the time-out and set the batch size to 
twenty jobs, the Client automatically cancels the batch if more than a minute 
elapses before it detects the start of the second job in the batch. 

Authentication 

This section controls how Print Audit authenticates users. Print Audit determines 
who the user is before allowing access to the Print Audit tools and before it 
allows them to print. 

Client Authentication - This controls how the Client determines who the user is. 
Use the drop-down box to choose an authentication type. 
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There are three authentication types. They are as follows: 

 Logged in User - The Client uses the current Windows or Novell login 
information to identify the user. 

 PIN - The Client requires the user to enter their Print Audit PIN code to 
identify the user. 

 PIN and Password - The Client requires the user to enter their Print Audit 
PIN and a separate password to identify the user. 

 Network - The Client requires the user to re-enter their Windows or Novell 
login information to identify the user. The Client does not store or transmit 
this information anywhere. Please note that this type of authentication may 
not work properly on Windows 95, Windows 98 and Windows Millennium 
depending on your network configuration. 

Tools Authentication - This controls how the Print Audit Administration, Job 
Manager and other tools determine who the user is. Use the drop-down box to 
choose an authentication type. The authentication options for both Client and 
Tools are identical. 

You can set Client Authentication per computer, and choose to report the users 
as Windows NT, Active Directory or Novell Directory Services. For more 
information on these advanced settings, please see the Network and 
Authentication settings section. 

Disconnected Jobs 

This section allows you to configure how Print Audit deals with print jobs that 
occur when the Client cannot connect to the Database Communicator. 

Disconnected Job Option - This controls exactly what Print Audit does when it 
detects a print job, but no connection to the Database Communicator. Options 
are: 

 Track normally - The jobs are tracked and stored on the local computer. 
When the Client can connect to the Database Communicator it uploads all 
of the locally tracked jobs to the database. If the jobs require more 
information, the Client requests more information from the user. 

 Track silently - The same as above, except that the user is never asked 
for further information, the jobs are stored in the database the same as if 
they were set to "Track with no popup". 

 Ignore Jobs - Any jobs printed in a disconnected state are not tracked. 
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 Disallow jobs - The Client cancels the job, and displays a message to the 
user. 

 Ignore old jobs - Same as Track Normally, except that any jobs older 
than the specified number of days are ignored. 

Disconnected Disallowed Message - This is the message that displays to the 
user if their job was disallowed due to no connection to the Database 
Communicator. This is only available if "Disallow jobs" is set for the disconnected 
job option. 

Number of Days Until Old - This is the number of days old the job must be 
before it is ignored. Only available if "Ignore old jobs" is set for the disconnected 
job option. 

NOTE: It is possible to specify the disconnected job settings per desktop 
computer.  

Custom Rules 

Overview 

New in Print Audit 6 is the ability for you to create custom rules. These rules can 
allow you to handle almost any printing control needs within your organization. 

 
Using Custom Rules you can select one or more conditions that trigger one or 
more actions to take place within the software. For example, you could allow 
free printing after a certain time of day, send an email to people if jobs of a 
certain size are printed, display messages to users, etc. You can also define 
rules that depend on other rules being triggered, so the possibilities are 
endless. 
 
For most printing needs, such as basic limits and pricing, you can use our User 
Profiles, Applications or Printer Profiles for your needs, but for complex printing 
situations and environments Custom Rules may be required. When you define a 
Custom Rule, the behavior you define in the rule overrides any other settings 
that you may have made in other areas of the application. 
 
Rules work by evaluating one or more conditions you define, and if those 
conditions are met the rule triggers one or more actions you define. It is very 
simple to define rules, but given the combinations of actions and conditions you 
can create rules to handle very complex situations. 
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For ease of administering rules, you can create and manage user and printer 
rule groups. You can define groups for departments for example, and set rules 
to run only for those departments. These groups are separate from reporting 
groups you can define in the Job Manager and Analysis Reporting. 

 
You can do the following with Custom Rules section of the Administrator: 

 
 Adding, Editing and Deleting Custom Rules 
 Add, Edit and Delete Rule Groups 

  

Adding, Editing and Deleting Custom Rules 

You use the Custom Rules section of the Administration tool to add, edit and 
delete custom rules. Please follow the steps in the sections below. 

 
To add a new custom rule: 

 
1. Click on the Advanced header on the left hand side of the 

Administration window. The list of advanced sections of the 
Administration tool display. 

2. Click on the Custom Rules button on the left hand side of the 
Administration window. The list of custom rules appears in the right 
hand side. 

3. Double-click on an empty row in the list in the Custom Rules section or 
click the New button on the toolbar. The Custom Rules window 
appears.  

4. Enter the rule information as applicable.  
5. Click the Add button. The custom saves to the database and the 

window closes. 
 

To edit an existing custom rule: 
 

1. Click on the Advanced header on the left hand side of the 
Administration window. The list of advanced sections of the 
Administration tool display. 

2. Click on the Custom Rules button on the left hand side of the 
Administration window. The list of custom rules appears in the right 
hand side. 

3. Double-click on the custom rule you want to edit in the list in the 
Custom Rules section. The Custom Rules window appears. 
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4. Make your changes as appropriate.  
5. Click the Save button. The Custom Rules window closes and you see 

your changes displayed in the list. 
 

To delete existing custom rule: 
 

1. Click on the Advanced header on the left hand side of the 
Administration window. The list of advanced sections of the 
Administration tool display. 

2. Click on the Custom Rules button on the left hand side of the 
Administration window. The list of custom rules appears in the right 
hand side. 

3. Click on the custom rule you want to delete. The row appears 
highlighted. 

4. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete 
the rule. 

5. Click the Yes button on the message box to delete the rule. The list 
refreshes to show the rule was deleted. 

Rule Conditions 

You can define a rule with one or more of the following conditions: 
 

 User - The user who is printing is or is not a Print Audit user you select. 
 User Profile - The user who is printing belongs to, or does not belong 

to the User Profile you select. 
 Printer - The printer you are printing to is or is not a printer you select. 
 Printer Profile - The printer you are printing to belongs to, or does not 

belong to the Printer Profile you select. 
 Computer name - The name of the computer you are printing from 

matches fully or partially the computer name you enter. 
 Time of day - The user is printing the job before or after a defined time, 

or is being printed between or outside of a range of time. 
 Total page count - The total page count of the job the user is printing 

is a certain size, within a certain range, or is greater than or less than a 
value you enter. 

 Total color page count - The total number of color pages in the job the 
user is printing is a certain size, within a certain range, or is greater 
than or less than a value you enter. 



 

 

14 

 Total mono page count - The total number of black and white pages in 
the job the user is printing is a certain size, within a certain range, or is 
greater than or less than a value you enter. 

 Total units in the job - The total number of units in the job, taking into 
account Pricing Option, is a certain number, within a certain range or is 
greater than or less than a value you enter. 

 Total color units in the job - The total number of color units in the job, 
taking into account Pricing Option, is a certain number, within a certain 
range or is greater than or less than a value you enter. 

 Total mono units in the job - The total number of black and white 
units in the job, taking into account Pricing Option, is a certain number, 
within a certain range or is greater than or less than a value you enter. 

 Total job cost - The total cost of the job, after the user completes the 
Client Popup, is equal to, less than or greater than or within a range of 
values you enter. 

 Job duplex setting - The job the user printed was printed duplex or 
not. 

 Job n-up setting - The job the user printed was printed was printed 
using n-up, with, greater than, less than or within a range of the number 
you specify. 

 Job origin - The print job came from, or did not come from a specific 
environment. 

 Job type - The type of job is or is not of a specific type (print, plot, etc.) 
 Job was printed to file - If the job was printed to file or not. 
 Document title - The title of the document being printed equals, does 

not equal or partially matches what you enter. 
 Printer group - The printer the user is printing to does or does not 

belong to a specific printer rule group. 
 User group - The user printing does or does not belong to a specific 

user rule group. 
 Driver color mode - The color mode we detect from the driver is black 

and white or color. 
 Application name - The process name of the application printing is, is 

not or partially matches the value you enter. The application does not 
need to be in your Applications list. 

 Job satisfies rule - The job satisfies or does not satisfy the conditions 
of another rule you created. 

 Base job cost - The cost of the job before the Client Popup is shown 
is, is not, or is within a range of a value you enter. 

 Day of the week - The job was or was not printed on a selected day. 
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 Number of Copies - The number of copies in the job is, is not, or is 
within a range of a value you enter. 

Rule Actions 

You can define a rule with one or more of the following actions: 
 

 Set track option to - Set the overall tracking option for the job to the 
specified value. 

 Set authentication type to - Set the Client authentication to the 
selected value. 

 Display message and cancel the job - Displays a message to the 
user printing, and cancels the job. You can define the title of the 
message, as well as the text. You can use message variables in the 
text to provide a message targeted for the user and situation. 

 Display message and present option to cancel the job - Displays a 
message to the user printing, and allows them to decide if they want to 
cancel the job or not. You can define the title of the message as well as 
the text. You can use message variables in the text to provide a 
message targeted for the user and situation. 

 Display message and continue the job - Displays a message to the 
user printing, and once they acknowledge, the message continues. You 
can define the title of the message as well as the text. You can use 
message variables in the text to provide a message targeted for the 
user and situation. 

 Send an e-mail message - Sends an email message. You can define 
the email address it appears to come from, the list of users who it is to, 
a subject and text. You can use message variables in the text to 
provide a message targeted for the user and situation. You can specify 
multiple addresses in the To and CC fields, separated by a comma. 
NOTE: To properly send emails, you must configure the email settings 
in the System Settings section of the Administrator. 

 Do not deduct job cost from user balance - The jobs cost will not be 
deducted from any user balances. 

 Set the cost profile - You can define detailed pricing for the rule. 
Please see the Printer Profile Window topic for a description of the 
pricing fields. 

 Ask for custom fields - Require the user to enter the custom fields you 
select on the Client Popup before they can print. If you clear all of the 
fields, the user does not need to enter any custom fields. 
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 Ignore all printing limits - Ignore any printing limits defined in the User 
Profile, Application or Printer Profile. However, any limits on cost or 
pages you setup in other custom rules may still apply. 

Rule Groups 

Print Audit 6 allows you to create user and printer rule groups. You can use 
these groups to make administering your rules even easier. For example, you 
could define rule groups based on department or responsibility, add users to 
rule groups, and then create rules whose action list requires membership in one 
or more groups. While similar in implementation, rule groups are not related to 
the reporting groups you can create in the Job Manager and Analysis Reporting 
tools. 
 
To add, edit and delete user rule groups: 

 
1. Click on the Advanced header on the left hand side of the 

Administration window. The list of advanced sections of the 
Administration tool display. 

2. Click on the Custom Rules button on the left hand side of the 
Administration window. The list of custom rules appears in the right 
hand side. 

3. Click the Groups->Edit User Groups menu item at the top of the 
Administration Window. The Edit User Groups window appears. 

4. Click Add to create a new group, or click an existing group to highlight it 
and click the Edit button. The Edit Group window appears. 

5. Add or Remove members from the group, and click the Save button on 
the Edit Group window. 

6. Repeat steps 4 and 5 to modify more groups. 
7. If you want to delete an existing group, click an existing group to 

highlight it and click the Delete button. A message displays asking if 
you are sure you want to delete the group. Click Yes to continue. 

8. Click Close on the Edit User Groups window. 
 

To add, edit and delete printer rule groups: 
 

1. Click on the Advanced header on the left hand side of the 
Administration window. The list of advanced sections of the 
Administration tool display. 
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2. Click on the Custom Rules button on the left hand side of the 
Administration window. The list of custom rules appears in the right 
hand side. 

3. Click the Groups->Edit Printer Groups menu item at the top of the 
Administration Window. The Edit Printer Groups window appears. 

4. Click Add to create a new group, or click an existing group to highlight it 
and click the Edit button. The Edit Group window appears. 

5. Add or Remove members from the group, and click the Save button on 
the Edit Group window. 

6. Repeat steps 4 and 5 to modify more groups. 
7. If you want to delete an existing group, click an existing group to 

highlight it and click the Delete button. A message displays asking if 
you are sure you want to delete the group. Click Yes to continue. 

8. Click Close on the Edit User Groups window. 

Client Custom Fields 

Overview 

Print Audit 6 allows you to define up to five custom fields the user must enter 
information for before they can print. Each one of these custom fields can have 
completely different values and types, allowing you to gather from your users 
valuable business information for each print job. 

 
For all types of custom fields except for non-validated, your users must enter 
information on the Client Popup in order to print. 

 
 The Client Custom Fields section consists of two to three main grids. The top 
grid contains a list of all the custom fields you define. The bottom grid contains 
a list of all the values you enter for a specific field. To see values for a field, click 
on the field in the top grid to select it. All of the values automatically display in 
the values grid below. For linked custom field types there are two values grids. 
The top values grid contains all of the main codes, the bottom values grid 
contains sub codes for the main code. 

 
You can use this section to do several things. Click on the links below for 
detailed information: 

 
 Adding, Editing and Deleting Custom Fields 
 Adding, Editing and Deleting Custom Field Values 
 Importing and Exporting Custom Field Values 
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 Linked Custom Fields 
 

You can configure Print Audit to display different custom fields depending on  
user, printer and/or application.  

Custom Field Types 

When you create a custom field you can choose from one of seven custom field 
types. The field types you can choose from are as follows: 

  
 Searchable - This field type uses a separate popup search window for 

searching on values from the Client. It keeps track of the last ten used 
values and supports an unlimited number of values. This field type also 
supports adding new values from the Print Audit Client. 

 Searchable Drop down - This field type uses a type-ahead drop down 
box search so the user does not need to use a separate search window. 
It keeps track of the last ten used values, but only supports fields that 
have up to one thousand values. This field type supports adding new 
values from the Client. 

 Simple Drop down - This field type is not searchable, a user simply 
selects an entry from the drop down. It does not keep track of the last ten 
used values, and only supports fields that have up to one hundred 
values. It does not support adding new values from the Client. This field 
works best for a small set of selectable items for a print job, such as 
added materials needed like binding or shipping. 

 Option - Not searchable, displays a pair of option buttons for the field. It 
supports only two values. Used generally for "yes, no" options like 
Billable and Non-Billable for example. 

 Non-Validated - This is a free format entry field. No validation is done on 
what a user enters here. 

 Linked Searchable - This field acts as two separate fields and allows 
the user to choose a main code followed by a sub code. The main code 
is a searchable type field, the sub code is a searchable drop down. 

 Linked Drop down - This field acts as two separate fields and allows the 
user to choose a main code followed by a sub code. Both the main code 
and sub code fields act as searchable drop downs. 

 
 



 

 

19 

Adding, Editing and Deleting Custom Fields 

You use the Client Custom Fields section of the Administration tool to add, edit 
and delete custom fields. You can also change the order in which the custom 
fields appear on the Client Popup window. Please follow the steps in the 
sections below. 

 
To add a new custom field: 

 
1. Click on the Client Custom Fields button on the left hand side of the 

Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Double-click on an empty row in the top list in the Client Custom fields 
section or click in the top list and then click the New button on the 
toolbar. The Adding New Field window appears.  

3. Enter the name of the field in the Name text field. This name depends 
on your business, but examples are Project, Client, Account, etc. You 
must enter a unique name for each custom field. 

4. Select the type of field from the Type drop down.  
5. Click the Save button. The Adding New Field window closes and you 

should see your new field listed in the top list. 
 

To edit an existing custom field: 
 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Double-click on the field you want to edit in the top list in the Client 
Custom fields section. The Editing Field window appears. 

3. Make your changes as appropriate. See the above section to see the 
fields you can change. 

4. Click the Save button. The Editing Field window closes and you see 
your changes displayed in the top list. 

 
To change the order of a custom field: 
 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field you want to move in the top list in the Client Custom 
fields section. The row containing the field is highlighted. 
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3. Click the Up or the Down arrow buttons on the toolbar at the top of the 
Administration window to change the order of the custom field. 

 
To delete an existing custom field: 

 
1. Click on the Client Custom Fields button on the left hand side of the 

Administration window. The Client Custom Fields section appears in the 
right hand side. 

 
2. Click on the field you want to delete in the top list in the Client Custom 

fields section. The row containing the field is highlighted. 
3. Click the Delete key on the toolbar at the top of the Administration 

window. A message appears asking you to confirm you want to delete 
the field. 

4. Click the Yes button on the message box to delete the field. The top list 
refreshes to show the field was deleted. 

 
NOTE: You cannot delete a custom field if it is referenced in a database print 
job. 

Linked Custom Fields 

New to Print Audit are linked custom fields. This feature allows you to specify a 
main and a sub code for a custom field. The main code a user selects 
determines which sub codes are available for entry.  
 
For example, you could define a linked custom field with "Customer" as the 
main field, "Project" as the sub field. You could then enter all of your customers 
into the Customer values list, and for each customer, enter the valid projects. 
When a user prints, they can first select the Customer and then see a list of only 
those projects for that customer. 
 
For the most part, using Linked Custom Fields is very simple, and similar to how 
normal custom fields work in Print Director Print Audit. However, there are some 
differences. They are as follows: 
 

 You cannot specify cost modifiers or budgets for main codes, only sub 
codes. 

 When importing values for linked custom fields, you must use the proper 
import format. 
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 When adding or editing custom field values for linked fields, the process 
is different.  

Adding, Editing and Deleting Custom Field Values 

You use the Client Custom Fields section of the Administration tool to add, edit 
and delete custom values for a field. Please follow the steps in the sections 
below. 

To add a new custom value: 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field you want to add values for in the top list. A list of all 
values for that field appear below. 

3. If you are editing a linked custom field type, there are two lists of 
values. The top list contains the main code values, the bottom list 
contains the sub code values. Selecting a value in the main code list 
shows the child codes for that value in the bottom list. 

4. Double-click on an empty row in the bottom list in the Client Custom 
fields section, or click in the bottom list and click the New button on the 
toolbar. The Adding New Value window appears. 

5. Enter the information for the new value.  
6. Click the Add button. The value saves to the database and the window 

sets up to add the next value. 
7. Click the Close button if you are done adding values. This will close the 

window and refresh the values. You can also continue steps 4 through 
5 to continue adding values. 

To add a new custom value from the Popup window: 

1. Double-click on the custom field for which you want to add a value on 
the Client Popup window. A dialog appears asking you for the code and 
description. 

2. Enter the new code and description and click Add button. The new 
value gets added to the database. 

3. NOTE: A user can only add codes for the Searchable and Searchable 
drop down field types. A user must also have permission to add codes 
from the Popup.  
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To edit an existing custom value: 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field you want to edit values for in the top list. A list of all 
values for that field appear in the bottom list. 

3. If you are editing a linked custom field type, there are two lists of 
values. The top list contains the main code values, the bottom list 
contains the sub code values. Selecting a value in the main code list 
shows the child codes for that value in the bottom list. 

4. Double-click on the value you want to edit in the bottom list in the Client 
Custom fields section. The Editing Value window appears. 

5. Make your changes as appropriate.  
6. Click the Save button. The Editing Value window closes and you see 

your changes displayed in the top list. 

To edit multiple custom values at once: 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field you want to edit values for in the top list. A list of all 
values for that field appear in the bottom list. 

3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list 
of values you want to edit. NOTE: You cannot edit multiple parent 
values at the same time if using a linked custom field type. You can edit 
multiple child values at the same time however. 

4. Click the Edit button on the toolbar. The Editing Value window 
appears. Please note that not all fields are editable when making 
changes to multiple values at once. 

5. Make your changes as appropriate.  
6. Click the Save button. The Editing Value window closes and you see 

your changes displayed in the top list. 

To delete existing custom values: 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field you want to delete values for in the top list. A list of all 
values for that field appear in the bottom list. 
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3. If you are editing a linked custom field type, there are two lists of 
values. The top list contains the main code values, the bottom list 
contains the sub code values. Selecting a value in the main code list 
shows the child codes for that value in the bottom list. 

4. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list 
of values you want to delete. If you want to delete only one value, you 
can simply click on it. 

5. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete 
the value(s). 

6. Click the Yes button on the message box to delete the values. The 
bottom list refreshes to show the values were deleted. 

 
NOTE: You cannot delete a custom field value if it is referenced in a database    
print job. If you delete a main code in a linked custom field, it deletes all child 
values. 

Importing Custom Field Values 

Print Audit allows you to import custom field values from a comma-delimited file 
on a one time or scheduled basis. This allows you to keep your master list of 
values in an accounting package or other piece of software and easily 
synchronize them with the codes in Print Audit. You can also import values from 
a generic flat file. 

 
To import values into a field: 

 
1. Click on the Client Custom Fields button on the left hand side of the 

Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field for which you want to import values in the top grid. 
The field row is highlighted. 

3. Click the Import button on the toolbar at the top of the Administration 
window. The Import Values window appears. 

4. Select the Import Type using the drop down on the window Import 
Values window. See Custom Value Import Formats for a description of 
the different import formats. 

5. On the Import tab, select the file containing the values you want to 
import. Please note that this file must be in the format specified by the 
import format you selected in step 4. 
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6. Check the Advanced tab to ensure settings are appropriate for what 
you want to do. See the Import Values window help for more 
information on the Advanced tab. 

7. Click the Import button. Print Audit begins to import the values from the 
file. 

8. Once the import is complete, a message displays indicating whether or 
not the import was successful. The import window closes and the list 
refreshes. 

 
To run the import on a scheduled basis: 

 
1. To run scheduled, simply follow the steps 1-6 in the above section. 

Then: 
2. Check the scheduling settings on the Scheduling tab on the Import 

Values window. Ensure the settings reflect the type of schedule you 
want. 

3. Click the Schedule button to add the task to the Windows Task 
Scheduler. 

 
You can schedule a separate import for each custom field you define. 

 
To remove a scheduled import: 

 
1. Click on the Client Custom Fields button on the left hand side of the 

Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field for which you want to cancel the import in the top grid. 
The field row is highlighted. 

3. Click the Import button on the toolbar at the top of the Administration 
window. The Import Values window appears. 

4. Click the Remove Schedule button to remove the task from the 
Windows Task Scheduler. 

 
OR 

  
Remove the task from the Windows Task Scheduler using its interface. 

Custom Field Value Import Formats 

The custom value importers require that the file you want to import is in a 
specific format. Below are the types of importers and their format requirements. 
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Comma-Delimited (Flat File) 

This importer uses a comma-delimited file format. The columns are in the 
following order: 

 
Code, Description, Cost Modifier, Modifier Type, Use Budget, Budget, Active 

 
 Code - The code for the value. Must be unique for the field. This is the 

only required column. 
 Description - A user friendly description for the value. If omitted, the 

Administrator leaves the description of the value blank. 
 Cost Modifier - The cost modifier. If omitted assumes zero for cost 

modifier types, 100 for percentage modifier types. This type is used for 
both b/w and color unit costs if a unit modifier. If you need to specify 
separate b/w and color modifiers, please use the Print Audit 6 format. 

 Modifier Type - A number indicating the type of modifier. 0 - Unit cost, 
1 - Unit percentage, 2 - Job cost, 3 - Job percentage. If blank, Print 
Audit assumes unit percentage. 

 Use Budget - Whether or not this value uses a budget. 0 - Not using a 
budget, 1 - Using a budget. 

 Budget - The amount in the budget for this value. 
 Active - Whether or not the code is currently active. A value of 0 means 

inactive, 1 means active. If blank, the Administrator assumes active. 

Print Audit 4 

This importer uses the same format as the Validated Value importing/exporting 
from Print Audit 4. The format is a comma-delimited file in the following order: 

  
Code, Description, Cost Modifier, Active 

  
 Code - The code for the value. Must be unique for the field. This is the 

only required column. 
 Description - A user friendly description for the value. If omitted, the 

Administrator leaves the description of the value blank. 
 Cost Modifier - A unit percentage modifier. If omitted, the Administrator 

uses a default of 100. The same modifier is applied for both color and 
b/w unit percentages. 

 Active - Whether or not the code is currently active. A value of 0 means 
inactive, 1 means active. If blank, the Administrator assumes active. 
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Print Audit 5 

This importer uses a comma-delimited file format. The columns are in the 
following order: 
Code, Description, Cost Modifier, Modifier Type, Use Budget, Budget, Active 
 

 Code - The code for the value. Must be unique for the field. This is the 
only required column. 

 Description - A user friendly description for the value. If omitted, the 
Administrator leaves the description of the value blank. 

 Cost Modifier - The cost modifier. If omitted assumes zero for cost 
modifier types, 100 for percentage modifier types. This modifier type is 
used for both b/w and color unit costs if it is a unit modifier type. 

 Modifier Type - A number indicating the type of modifier. 0 - Unit cost, 
1 - Unit percentage, 2 - Job cost, 3 - Job percentage. If blank, the 
Administrator assumes unit percentage. 

 Use Budget - Whether or not this value uses a budget. 0 - Not using a 
budget, 1 - Using a budget. 

 Budget - The amount in the budget for this value. 
 Active - Whether or not the code is currently active. A value of 0 means 

inactive, 1 means active. If blank, the Administrator assumes active. 
 

Print Audit 6 

This importer uses a comma-delimited file format. The columns are in the 
following order: 
 
Code, Description, Cost Modifier, Color Cost Modifier, Modifier Type, Use 
Budget, Budget, Active 

 
 Code - The code for the value. Must be unique for the field. This is the 

only required column. 
 Description - A user friendly description for the value. If omitted, the 

Administrator leaves the description of the value blank. 
 Cost Modifier - The cost modifier for b/w unit costs or percentages if a 

unit type modifier. If a job type modifier this is the value for the job.  If 
omitted assumes zero for cost modifier types, 100 for percentage 
modifier types. 
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 Color Cost Modifier - The cost modifier for color costs or percentages. 
It has no effect for job type modifiers. If omitted, assumes zero for cost 
modifier types, 100 for percentage modifier types. 

 Modifier Type - A number indicating the type of modifier. 0 - Unit cost, 
1 - Unit percentage, 2 - Job cost, 3 - Job percentage. If blank, the 
Administrator assumes unit percentage. 

 Use Budget - Whether or not this value uses a budget. 0 - Not using a 
budget, 1 - Using a budget. 

 Budget - The amount in the budget for this value. 
 Active - Whether or not the code is currently active. A value of 0 means 

inactive, 1 means active. If blank, the Administrator assumes active. 

Print Audit 6 Linked Values 

This import format is the only valid format for importing custom values into 
Linked type custom fields. It is as follows: 
 
Parent Code, Parent Description, Child Code, Child Description, Cost Modifier, 
Color Cost Modifier, Modifier Type, Use Budget, Budget, Active 

 
 Parent Code - The code for the main code in the linked pair. Required. 
 Parent Description - The description for the main code in the linked 

pair. If blank, the description is left blank. 
 Child Code - The child code for the value. Required. The combination 

of parent code and child code must be unique. 
 Child Description - A user friendly description for the child value. If 

omitted, the Administrator leaves the description of the value blank. 
 Cost Modifier - The cost modifier for b/w unit costs or percentages if a 

unit type modifier. If a job type modifier this is the value for the job.  If 
omitted assumes zero for cost modifier types, 100 for percentage 
modifier types. 

 Color Cost Modifier - The cost modifier for color costs or percentages. 
It has no effect for job type modifiers. If omitted, assumes zero for cost 
modifier types, 100 for percentage modifier types. 

 Modifier Type - A number indicating the type of modifier. 0 - Unit cost, 
1 - Unit percentage, 2 - Job cost, 3 - Job percentage. If blank, the 
Administrator assumes unit percentage. 

 Use Budget - Whether or not this value uses a budget. 0 - Not using a 
budget, 1 - Using a budget. 

 Budget - The amount in the budget for this value. 



 

 

28 

 Active - Whether or not the code is currently active. A value of 0 means 
inactive, 1 means active. If blank, the Administrator assumes active. 

Exporting Custom Field Values 

You can export the custom values for a field to a comma-delimited file. You can 
then use this file for importing into other programs that may need the value list. 
Print Audit uses two slightly different formats depending on whether you are 
exporting a linked or a non-linked custom field. 
 
For non-linked custom fields, the format is as follows: 
Code, Description, BW Cost Modifier, Color Cost Modifier, Modifier Type, Use 
Budget, Budget, Active 
 
For linked custom fields, the format is as follows: 
Parent Code, Parent Description, Child Code, Child Description, BW Cost 
Modifier, Color Cost Modifier, Modifier Type, Use Budget, Budget, Active 
 
To export custom field values from a field: 
 

1. Click on the Client Custom Fields button on the left hand side of the 
Administration window. The Client Custom Fields section appears in the 
right hand side. 

2. Click on the field for which you want to export values in the top grid. 
The field row is highlighted. 

3. Click the Export button on the toolbar at the top of the Administration 
window. A standard Windows dialog appears. 

4. Use the dialog to select a file to export the information to and click the 
Save button. The information starts to export. 

5. After the export completes a message box appears letting you know 
how many values were exported. 

 
NOTE: For custom field values that use percentage modifier types, the Color 
Cost Modifier column is ignored, and the BW Cost Modifier column contains the 
overall percentage modifier. 
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User Profiles 

Overview 

Print Audit allows you to assign tracking and security options to users with user 
profiles. There are two types of user profiles: Tracking Profiles and Security 
Profiles. You can assign the same profile to multiple users, allowing you to 
quickly set up how you want users to behave in Print Audit. 

Tracking Profiles control how Print Audit tracks printing from the user. This 
includes things such as how jobs are tracked, what options they have on the 
Client Popup Window, if they have custom pricing, printing limits or cost/page 
allowances. 

Security Profiles control what the user can do in the Print Audit tools. For 
example you can assign the "Administrator" profile to a user to give them full 
access to configure Print Audit. You can set individual Print Audit policies to 
control things such as user management, printer management and job exporting. 

Print Audit assigns all users to the "Administrator" profile by default. It does this 
to ensure you do not lock yourself out of the database accidentally when you first 
install. If you want new users to have other profiles than "Administrator", you can 
use this section to assign different defaults. You MUST have one user at all times 
as the Print Audit Administrator. Print Audit does try to protect you from removing 
the last administrator. If you somehow do remove the last Administrator you will 
not be able to use the Administration tool at all. 

Print Audit ships with some standard profiles already defined. You can modify 
these profiles to suit your business needs, or create new profiles to assign. We 
recommend you do not modify the Print Audit Administrator security profile. 

You can do the following in this section: 

 Set the default Tracking Profile 
 Add, edit and delete Tracking Profiles 
 Define Allowances 
 Reset user balances. 
 Set the default Security Profile 
 Add, edit and delete Security Profiles 
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Allowances and Balances 

Print Audit 6 allows you to set define cost or page balances for users. Whenever 
a user prints a job, its value is automatically deducted from the user's balance 
until none is remaining. If the user runs out, they can no longer print. To view an 
individual user's current balances, you can view the individual user in the Users 
section of the Administrator. 

There are three major pieces that tie into user balances: 

Allowances 

An allowance is the default balance assigned to a user. You set up allowances 
on the User Tracking Profile, and whenever a user is assigned to the profile their 
balances get set to the allowance you define. The types of allowances are as 
follows: 

 Total Pages - The total number of pages a user can print before they run 
out. Counts both b/w and color pages. 

 B/W Pages - The total number of b/w pages a user can print before they 
run out. Allows unlimited color printing. 

 Color Pages - The total number of color pages a user can print before 
they run out. Allows unlimited b/w printing. 

 B/W and Color Pages - The total number of b/w and color pages they can 
print. If either allowance runs out, the user won't be able to print any more 
pages of that type. 

 Cost - The total cost of print jobs the user is allowed to print before the 
allowance runs out. 

You can set allowance balances to auto-reset periodically. For example, you 
could define an allowance of 50 total pages that resets the first of every month. 
At any point you can manually reset a user's balance. 

Additional Balances 

In some cases, you may want to have a separate balance for a user that does 
not reset when their allowance does. For example, in an educational institution a 
student may purchase extra printing outside of their normal allowance. This 
balance never automatically resets, although you can choose to manually reset 
it.  
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The additional balance is of the same type as the allowance, so it is not possible 
to have an allowance of total pages and an additional balance of cost for 
example. 

If additional balances are enabled, printing is taken first from any remaining 
allowance, and then taken from the additional if the allowance runs out. 

Overdraft 

In some cases, you may want to allow users to be able to still print even if their 
balance is negative. In this case, you can assign an overdraft amount to the User 
Profile. For example, if you have a 50 page allowance you could set a 5 page 
overdraft to give a bit of leeway to your users. 

Setting the Default User Tracking Profile 

Print Audit uses a Tracking Profile you select as the "default" profile. Print Audit 
automatically assigns this default profile to users the first time they print. 

You can change the default Tracking Profile at any time. When you change the 
default it only affects new users it does not change existing users in the User list. 

To set the default Tracking Profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Tracking Profiles Tab in the User Profiles section. A list of all 
defined Tracking Profiles appears. 

3. Use the Default Profile drop down box located at the top of the tab to 
select the new profile to use as the default. Print Audit now assigns the 
profile you selected to any new users that appear in the Users section 

Adding, Editing and Deleting Tracking Profiles 

You use the User Profiles section of the Administration tool to add, edit and 
delete Tracking Profiles. Please follow the steps in the sections below. 

To add a new tracking profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 
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2. Click the Tracking Profiles Tab in the User Profiles section. A list of all 
defined Tracking Profiles appears. 

3. Double-click on an empty row in the Tracking Profiles list, or click the New 
button on the toolbar. The Tracking Profile window appears. 

4. Enter the information for the new profile. Click here for details on the 
Tracking Profile window. 

5. Click the Add button. The value saves to the database and the window 
sets up to add the next profile. 

6. Click the Close button if you are done adding profiles. This will close the 
window and refresh the profiles. You can also continue steps 3 through 4 
to continue adding profiles. 

To edit an existing tracking profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Tracking Profiles Tab in the User Profiles section. A list of all 
defined Tracking Profiles appears. 

3. Double-click on the Profile you want to edit in the profile list. The Tracking 
Profile window appears. 

4. Make your changes as appropriate. Click here for details on the Tracking 
Profile window. 

5. Click the Save button. The Tracking Profile window closes and you see 
your changes displayed in the list. Please note that if you change the 
balance information Print Audit asks you if you want to reset your 
balances. Click here for more information on resetting balances. 

To delete existing tracking profiles: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Tracking Profiles Tab in the User Profiles section. A list of all 
defined Tracking Profiles appears. 

3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
profiles you want to delete. If you want to delete only one profile, you can 
simply click on it. 

4. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete the 
profiles(s). 

5. Click the Yes button on the message box to delete the profiles. The list 
refreshes to show the profiles were deleted. 
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NOTE: You can only delete a profile if no users exist that use it. 

Resetting User Balances 

You can easily reset the balances for every user in a Tracking Profile. You may 
want to reset the balances at the start of every month, or using some other 
criteria that makes sense for your business. Please note that Print Audit 
automatically asks you if you want to reset user balances when you change the 
starting balance on the profile window. 

You can also setup automatic balance resetting. 

To reset user balances: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Tracking Profiles Tab in the User Profiles section. A list of all 
defined Tracking Profiles appears. 

3. Double-click on the Profile you want to reset balances for in the profile list. 
The Tracking Profile window appears. 

4. Make sure the allowance values on the Allowances tab on the Tracking 
Profile window contains the value you want. 

5. Click the Reset User Balances button. The Reset Balances window 
appears. 

6. Click the option corresponding to the balance option you want. 
7. Check the Set additional balances to zero box if you want to reset 

additional balances along with the allowance balances. 
8. Click the Update button. A message appears asking you to confirm you 

want to update the balances. 
9. Click Yes to set the balances of all users that use the profile. 

Setting the Default User Security Profile 

Print Audit uses a Security Profile you select as the "default" profile. Print Audit 
automatically assigns this default profile to users the first time they print. 

You can change the default Security Profile at any time. When you change the 
default it only affects new users it does not change existing users in the User list. 
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To set the default Security Profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Security Profiles Tab in the User Profiles section. A list of all 
defined Security Profiles appears. 

3. Use the Default Profile drop down box located at the top of the tab to 
select the new profile to use as the default. Print Audit now assigns the 
profile you selected to any new users that appear in the Users section. 

Adding, Editing and Deleting Security Profiles 

You use the User Profiles section of the Administration tool to add, edit and 
delete Security Profiles. Please follow the steps in the sections below. 

To add a new security profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Security Profiles Tab in the User Profiles section. A list of all 
defined Security Profiles appears. 

3. Double-click on an empty row in the Security Profiles list, or click the New 
button on the toolbar. The Security Profile window appears. 

4. Enter the information for the new profile.  
5. Click the Add button. The value saves to the database and the window 

sets up to add the next profile. 
6. Click the Close button if you are done adding profiles. This will close the 

window and refresh the profiles. You can also continue steps 3 through 4 
to continue adding profiles. 

To edit an existing security profile: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Security Profiles Tab in the User Profiles section. A list of all 
defined Security Profiles appears. 

3. Double-click on the Profile you want to edit in the profile list. The Security 
Profile window appears. NOTE: We recommend you do not edit the 
Administrator security profile. 

4. Make your changes as appropriate.  
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5. Click the Save button. The Security Profile window closes and you see 
your changes displayed in the list. 

To delete existing security profiles: 

1. Click on the User Profiles button on the left hand side of the Administration 
window. The User Profiles section appears in the right hand side. 

2. Click the Security Profiles Tab in the User Profiles section. A list of all 
defined Security Profiles appears. 

3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
profiles you want to delete. If you want to delete only one profile, you can 
simply click on it. 

4. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete the 
profiles(s). 

5. Click the Yes button on the message box to delete the profiles. The list 
refreshes to show the profiles were deleted. 

NOTE: You can only delete a profile if no users exist that use it. 

Users 

Overview 

Print Audit automatically adds every user it detects to the user list. Over time this 
list contains every user in your organization that has printed. 

You use this list to assign tracking and security profiles, assign users to report 
groups, set PIN codes and/or passwords as well as check and set user balances. 

You can do the following with the users section: 

 Editing Users 
 Adding and Deleting Users (Advanced) 
 Importing and Exporting Users 

Adding and Deleting Users (Advanced) 

You can use Print Audit to add users to and delete users from the Users list. Print 
Audit automatically adds users to the list when they print, so you only need to 
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add/delete users if you have advanced requirements. Note that if you delete a 
user, it may re-appear as soon as they print. 

To add a new user: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Double-click on an empty row in the list or click the New button in the 
toolbar. The User window appears. 

3. Enter information for the user as applicable.  
4. Click the Add button. The user saves to the database and the window 

sets up to add the next user. 
5. Click the Close button if you are done adding users. This closes the 

window and refreshes the users. You can also continue steps 3 through 4 
to continue adding users. 

To delete a user: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Click on the user you want to delete in the user list. The user highlights. 
3. Click the Delete button on the toolbar at the top of the Administration tool. 

A message appears asking you to confirm that you want to delete. 
4. Click the Yes button to continue deleting the user. The user list refreshes 

to show that Print Audit deleted the user. 

NOTE: You can not delete users if they have print jobs in the database. 

Editing Your Users 

You may need to edit your users for several reasons. You edit users to 
add/change PIN codes, reset their user balances and assign them to different 
reporting groups. 

You also need to edit users to assign them to different tracking or security 
profiles. 
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To edit a user: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Double-click on the user you want to edit. The User window appears. 
3. Change the information as appropriate.  
4. Click the Save button. The User window closes and you should see 

changes reflected in the list. 

To edit multiple users at once: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
users you want to edit. 

3. Click the Edit button on the toolbar. The Update Multiple Users window 
appears.  

4. Make your changes as appropriate. Please note that you can only change 
the tracking profile, security profile, balance and reporting group when 
editing multiple users. 

5. Click the Update button. The Update Multiple Users window closes and 
you see your changes displayed in the list. 

To change/create PIN codes for multiple users at once: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
users whose PIN codes you want to change. 

3. Click the Edit->Generate PIN Codes menu item.  The Generate PIN 
Codes window appears.  

4. Enter the length of the PIN code you want to generate. 
5. Check the Numeric only box if you want to generate numeric only PIN 

codes. 
6. Check the Overwrite existing box if you want to overwrite PIN codes if 

they already exist. If unchecked Print Audit creates new PIN codes but 
does not overwrite existing PIN codes. 
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7. Click the Generate button. Print Audit generates new PIN codes for the 
users. To see a list of PIN codes for the users you can export the users to 
a flat file. 

NOTE: Resetting a PIN code for the user does not reset their PIN password. 

Importing Users 

Print Audit allows you to import a user list from a generic comma-delimited 
format, a Print Audit 4 format flat file, a Print Audit 5 format flat file, a Print Audit 6 
format flat file and from a domain. Please note that you can only import Windows 
users if you run the Administration tool on a Windows NT based computer. You 
can also schedule user imports to run whenever you like, keeping the users up to 
date. 

IMPORTANT - You do NOT need to import users. Print Audit automatically adds 
users to the database as they print. Only import users if you want to assign PIN 
codes to a large number of users at once, set their balances or groups. 

When importing users you can adjust several settings that affect how PIN codes, 
Balances and Groups are set for newly imported users. The options available are 
dependent on the type of import you are doing.  

NOTE: For advanced users the Network Type setting in the Network and 
Authentication Settings section controls which type of domain Print Audit 
attempts to import from; a Windows NT, Active Directory or Novell NDS domain. 

To import users: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Click the Import button on the toolbar at the top of the Administration 
window. The Import Users window appears. 

3. Select the Import Type using the drop down on the window Import Users 
window. See User Import Types for a description of the different types of 
user imports. 

4. Select the file you want to import for a Print Audit 4/5 import, or enter the 
domain you want to import users from for a Domain type import. Please 
note that the file you choose for a file-based import must be in the correct 
format. 
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5. Enter an organizational unit (OU) to limit the import to. This option is only 
available for Domain type imports, and if your Network Type is Active 
Directory or Novell NDS. 

6. Select the tracking profile, security profile for the import.  
7. Select your options for PIN, PIN Password, Balances and Grouping.  
8. Click the Import button. Print Audit begins to import the users. 
9. Once the import is complete, a message displays indicating whether or not 

the import was successful. The import window closes and the list 
refreshes. 

If you generate PIN codes for users you can export the users to get a list of all 
assigned PIN codes. 

To schedule user imports: 

1. Set up the import using the same steps 1-7 above. 
2. Click on the Scheduling tab. 
3. Use the Run Import drop down to select how often to run the import. 

Choices are Daily, Weekly or Monthly. 
4. Use the On drop down to select the day on which to run the import. This is 

only effective for Weekly or Monthly schedules. 
5. Use the At selector to select the time of day at which to run the import. We 

recommend using a time outside of regular business hours. 
6. Click the Schedule button. Print Audit creates an entry in the Windows 

task scheduler that when run imports users using the settings you defined. 

To unschedule user imports: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Click the Import button on the toolbar at the top of the Administration 
window. The Import Users window appears. 

3. Click the Unschedule button. If not enabled, you have no imports 
scheduled. You can also manually delete the task using the Windows 
Task Scheduler. 
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Exporting Users 

You can export the Print Audit user list to a comma-delimited file. Print Audit 
exports all user PIN codes so it is important to make sure you keep track of this 
file for security purposes. 

Print Audit creates a comma-delimited file, with the columns in the following 
order: 

PIN code, Display Name, Unique Name, Network Name, Domain, B/W 
Allowance Balance, B/W Additional Balance, Color Allowance Balance, Color 
Additional Balance, Account.   

To export users: 

1. Click on the Users button on the left hand side of the Administration 
window. The Users section appears in the right hand side. A list of all 
users Print Audit has tracked displays in the section. 

2. Click the Export button on the toolbar at the top of the Administration 
window. The Export Users To File window appears. 

3. Type in the file to export to, or use the browse button to select a file. 
4. Click the Export button on the window to export the users to the selected 

file. 

Printer Profiles 

Overview 

Print Audit 6 allows you to assign tracking and print cost information to printers 
through Printer Profiles. For example you use Printer Profiles to set whether 
Print Audit tracks printing from a printer, if it should track printing in pages, 
square footage, etc., as well as any printing limits you want to place on your 
printing device. You only need to create different Printer Profiles if you need to 
have different tracking or pricing options for different devices. You can set 
multiple printers to use the same Printer Profile. 

 
New to Print Audit 6 is the ability to determine which custom fields should 
display on the Popup based on printer, as well as extended job options when 
printing. Click here for more information on the new options. 
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Print Audit ships with two profiles already created, one for standard tracking one 
for ignoring printing. It sets the default profile to the tracking profile. 
 
You can use this section to do the following: 

 
 Set the default Printer Profile 
 Add, edit and delete Printer Profiles 

 
Printer Profiles do not take effect until assigned to one or more printers. 

Setting the Default Printer Profile 

  Print Audit uses a Printer Profile you select as the "default" profile. Print Audit 
automatically assigns this default profile to printers as it adds them to the 
Printers list. 

 
You can change the default Printer Profile at any time. When you change the 
default it only affects new printers it does not change printers that already exist 
in the Printer List. 

 
To set the default Printer Profile: 

 
1. Click on the Printer Profiles button on the left hand side of the 

Administration window. The Printer Profiles section appears in the right 
hand side. A list of all existing Printer Profiles displays in the list. 

2. Use the Default Profile drop down box located just above the Printer 
Profiles list to select the new profile to use as the default. Print Audit 
now assigns the profile you selected to any new printers that appear in 
the Printers section. 

Adding, Editing and Deleting Printer Profiles 

You use the Printer Profiles section of the Administration tool to add, edit and 
delete Printer Profiles. Please follow the steps in the sections below. 

 
To add a new printer profile: 

 
1. Click on the Printer Profiles button on the left hand side of the 

Administration window. The Printer Profiles section appears in the right 
hand side. A list of all existing Printer Profiles displays in the list. 
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2. Double-click on an empty row in the Printer Profiles list, or click the New 
button on the toolbar. The Adding New Printer Profile window 
appears. 

3. Enter the information for the new profile.  
4. Click the Add button. The profile saves to the database and the window 

sets up to add the next profile. 
5. Click the Close button if you are done adding profiles. This will close 

the window and refresh the profiles. You can also continue steps 3 
through 4 to continue adding profiles. 

 
To edit an existing printer profile: 

 
1. Click on the Printer Profiles button on the left hand side of the 

Administration window. The Printer Profiles section appears in the right 
hand side. A list of all existing Printer Profiles displays in the list. 

2. Double-click on the Profile you want to edit in the profile list. The 
Editing Printer Profile window appears. 

 
3. Make your changes as appropriate.  
4. Click the Save button. The Editing Printer Profile window closes and 

you see your changes displayed in the list. 
 

To add a printing limit to a printer profile: 
 

1. Follow the steps above to add a new profile or edit an existing profile. 
2. Click the Printing Limits tab on the Printer Profile window. 
3. Click the Add button on the Printer Profile window. The Printing Limit 

window appears. 
4. Select the type of limit you want.  
5. Enter the value you want for the limit. 
6. Enter the message you want displayed to the user if they exceed the 

limit. You can use message variables in the message. 
7. Check the Stop Job check box if you want Print Audit to stop the job 

from going to the printer if the job exceeds the limit. 
8. Click the Ok button to accept the changes to the limit. The window 

closes and you are back at the Printer Profile window. 
9. Repeat steps 3 to 8 to add more limits. 
10. Click the Add/Save button on the Printer Profile window to save the 

changes. 
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NOTE: When you add a limit Print Audit automatically changes to "wait for page 
count" mode. This mode causes Print Audit to wait until all pages are spooled 
before it displays the Popup window or any warnings. 

 
To delete existing printer profiles: 

 
1. Click on the Printer Profiles button on the left hand side of the 

Administration window. The Printer Profiles section appears in the right 
hand side. A list of all existing Printer Profiles displays in the list. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list 
of profiles you want to delete.  

 
      If you want to delete only one profile, you can simply click on it. 
3. Click the Delete key on the toolbar at the top of the Administration 

window. A message appears asking you to confirm you want to delete 
the profiles(s). 

4. Click the Yes button on the message box to delete the profiles. The list 
refreshes to show the profiles were deleted. 

 
NOTE: You can only delete a profile if no printers exist that use it. 

Printing Limits and Redirection 

In Print Audit you can setup multiple limit thresholds for Applications, Printer 
Profiles or User Track Profiles. You can use these limits to require users to print 
large jobs to more cost effective printers, limit the amount of color printing they 
can do to individual printers, limit the number of pages they can print from a 
website, and so on.  

 
Once a limit is hit, you can define the message that displays to the user, and 
either make the job cancel and have the user re-print the job to a different 
printer if needed, or just warn them about their behavior. 
 
Print Audit supports several types of limits. They are as follows: 
 

 Total pages - The total number of pages allowed. 
 B/W pages - The total number of b/w pages allowed. 
 Color pages - The total number of color pages allowed. 
 Total cost - The total cost of the job, after the Popup has been 

completed. 
 Base cost - The total cost of the job before the Popup displays. 
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Since it is possible to have limits defined in several different areas of the 
software, Print Audit processes limits as follows: 

 
1. "Stop" limits are processed before "Warn" limits. 
2. Limits are processed in order of Application, User, Printer. So if you 

have defined a limit for an Application and a similar limit in Printer, the 
message you entered for the Application limit will display. 

3. You can choose, for any individual Application, User Profile or Printer 
Profile to ignore any defined limits. So for example you could set limits 
at an Application level, but allow users that belong to a User Profile to 
print without triggering those limits. 

Printers 

Overview 

Print Audit 6 automatically adds printers to your printers list. Print Audit adds the 
printer the first time it detects a print job going to the printer. Over time this list 
contains every printing device in your organization. 

You use this list to assign profiles to printers as well as maintain device specific 
information.  

You can do the following with the Printers section: 

 Editing your Printers 
 Adding and Deleting Printers (Advanced) 

One of the most important topics when using Print Audit discusses how the 
software uses printer matching. The printer matching systems determine how 
Print Audit determines if the printer someone prints to from the Windows desktop 
matches one that already exists in the database. The systems are as follows: 

 Normal Printer Device Matching 
 Automatic Merging (Advanced) 
 Manual Merging (Advanced) 

The Printer Profiles section and the Printer Paper Sizes section work with the 
Printers section to determine how jobs are tracked and charged. Click the links to 
see more information on those sections. 
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Adding and Deleting Printers (Advanced) 

You can use Print Audit to add printers to and delete printers from the Printers 
list. Print Audit automatically adds printers to the list when printing, so you only 
need to add/delete printers if you have advanced requirements such as 
specialized printer matching. Note that if you delete a printer, it may re-appear as 
soon as someone prints to it. 

To add a new printer: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Double-click on an empty row in the list or click the New button in the 
toolbar. The Printer window appears. 

3. Enter information for the printer as applicable.  
4. Click the Add button. The Adding New Printer window closes and the 

new printer adds to the list. 

To delete a printer: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Click on the printer you want to delete in the printer list. The printer 
highlights. 

3. Click the Delete button on the toolbar at the top of the Administration tool. 
A message appears asking you to confirm that you want to delete. 

4. Click the Yes button to continue deleting the printer. The printer list 
refreshes to show that Print Audit deleted the printer. 

NOTE: You cannot delete printers if they have print jobs in the database. 
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Editing Your Printers 

You may need to edit printers from time to time, mainly to change the Printer 
Profile assigned to the printer, or to assign the printer to a different reporting 
group. You can also edit multiple printers at once. 

To edit a printer: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Double-click on the printer you want to edit. The Editing Printer window 
appears. 

3. Change the information as appropriate.  
4. Click the Save button. The Editing printer window closes and you should 

see changes reflected in the list. 

To edit multiple printers at once: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
printers you want to edit. 

3. Click the Edit button on the toolbar. The Update Multiple Printers 
window appears.  

4. Make your changes as appropriate. Please note that you can only change 
the tracking profile and reporting group when editing multiple printers. 

5. Click the Update button. The Update Multiple Printers window closes 
and you see your changes displayed in the list. 

Manual Printer Merging 

Print Audit supports manual printer merging. This allows you to take any set of 
print devices listed in the Printers List in the Administrator and merge the devices 
and all their jobs into one printer device. Print Audit remembers manual merges 
and automatically merges all future jobs accordingly. 

NOTE: This is intended for advanced users only. You should only use manual 
printer merging if you are sure the printer devices you are merging should be 



 

 

47 

reporting as only one device. If you merge devices there is no way to separate 
the job information back to the original printers. 

At any point you can "un-merge" a printer to remove all merging information. This 
does NOT restore the jobs to the separate printers but future print jobs are 
assigned to the separate devices. 

To view merged printers: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Printers that have other printers merged into them have a "plus" symbol to 
the left of their name. Click this symbol to expand the printers list to show 
all printers merged into that device.  

To manually merge printers: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Use CTRL-CLICK or SHIFT-CLICK to select the printers you want to 
merge. IMPORTANT: The first printer you select is the one Print Audit 
merges the rest of the printers into. So, for example, if you select printers 
A, B, C and D in that order, Print Audit merges all of B, C and D's jobs into 
printer A, and deletes printers B, C and D. 

3. Click the Advanced->Merge Printers menu. A window appears asking 
you if you are sure you want to merge these printers. 

4. Click the Yes button. Print Audit merges the printers and the jobs and 
refreshes the printer list. 

To un-merge a printer: 

1. Click on the Printers button on the left hand side of the Administration 
window. The Printers section appears in the right hand side. A list of all 
printers Print Audit has tracked displays in the section. 

2. Printers that have others merged into them have a "plus" symbol to the left 
of their name. Click this symbol to expand the printers list to show all 
printers merged into that device. 

3. Click on the merged printer you want to un-merge, and click the Delete 
button on the toolbar. A window appears asking if you are sure you want 
to delete the merge. 
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4. Click the Yes button. The merged printer now disappears from the list. It 
will be added as its own separate printer again the next time a user prints 
to it, but the previously merged jobs will not separate. 

NOTE: If the merged printer appears gray in the list, it is an automatically merged 
device and cannot be deleted. 

Printer Paper Sizes: 

Overview 

Print Audit 6 allows you to charge for print jobs based on the size of paper used 
to print the job. For example, you could set a cost of $0.10 per page for Letter 
sized pages, and $0.15 for Legal sizes. For very large paper sizes used in 
plotting of large drawings, you may want to use square footage or square meter 
tracking instead. 

To use paper size costing you need to ensure the paper sizes you use in your 
day to day business are included on the paper sizes list. You also need to set 
pricing in a User Profile, Printer Profile or Application to use "per paper size" as 
the print option and assign that profile to your printers. 

Print Audit ships with many of the standard paper sizes, you can add or modify 
them to suit your needs. You may want to look at each paper size and ensure the 
cost per page is correct for your business. 

You can use this section to do the following: 

 Adding, editing and deleting paper sizes 

Adding, Editing and Deleting Paper Sizes 

You use the Printer Paper Sizes section to add, edit and delete paper sizes. 
Printer Profiles use these paper sizes if you set the pricing option to "per paper 
size".  

To add a new paper size: 

1. Click on the Printer Paper Sizes button on the left hand side of the 
Administration window. The Printer Paper Sizes section appears in the 
right hand side. 
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2. Double-click on an empty row in the bottom list in the Printer Paper Sizes 
section, or click the New button on the toolbar. The Adding New Paper 
Size window appears. 

3. Enter the information for the new paper size.  
4. Click the Add button. The paper size saves to the database and the 

window sets up to add the next size. 
5. Click the Close button if you are done adding paper sizes. This will close 

the window and refresh the sizes. You can also continue steps 3 through 4 
to continue adding sizes. 

To edit an existing paper size: 

1. Click on the Printer Paper Sizes button on the left hand side of the 
Administration window. The Printer Paper Sizes section appears in the 
right hand side. 

2. Double-click on the paper size you want to edit in the paper size list. The 
Paper Size window appears. 

3. Make your changes as appropriate.  
4. Click the Save button. The Paper Size window closes and you see your 

changes displayed in the top list. 

To edit multiple paper sizes at once: 

1. Click on the Printer Paper Sizes button on the left hand side of the 
Administration window. The Printer Paper Sizes section appears in the 
right hand side. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
paper sizes you want to edit. 

3. Click the Edit button on the toolbar. The Update Paper Sizes Cost 
window appears. 

4. Enter the new costs you want to assign to the paper sizes. 
5. Click the Update button. The Update Paper Sizes Cost window closes 

and you see your changes displayed in the list. 

To delete existing paper sizes: 

1. Click on the Printer Paper Sizes button on the left hand side of the 
Administration window. The Printer Paper Sizes section appears in the 
right hand side. 

2. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
paper sizes you want to delete. If you want to delete only one paper size, 
you can simply click on it. 
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3. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete the 
paper size(s). 

4. Click the Yes button on the message box to delete the paper sizes. The 
list refreshes to show the paper sizes were deleted. 

Application 

Overview 

Print Audit 6 can determine whether or not to track printing from an application. 
By default, all applications are watched for print jobs. However you may have 
instances where you want to track printing from only one application, or you want 
to track printing from all applications except one. You may also have instances 
where you do not want users to be able to print information from an application. 

New to Print Audit 6, you can now define printing limits, job rules, custom pricing 
and specify which custom fields are used for the user at an application level.  

You DO NOT need to add every application you want to track to this list. Only 
add applications to the list if you have special tracking needs. Please note that 
unlike the Users and Printers list, Print Audit does not automatically add every 
application it detects printing from to the list. 

The Applications section in the Administration tool allows you to do the following: 

 Add, edit and delete applications 
 Limit the number of tracked applications 

Adding, Editing and Deleting Applications 

You use the Applications section of the Administration tool to add, edit and delete 
applications. Please follow the steps in the sections below. 

To add a new application: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The list of advanced sections of the Administration tool display. 

2. Click on the Applications button on the left hand side of the Administration 
window. The list of applications appears in the right hand side. 
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3. Double-click on an empty row in the list in the Applications section or click 
the New button on the toolbar. The Applications window appears.  

4. Enter the application information as applicable.  
5. Click the Add button. The application saves to the database and the 

window sets up to add the next application. 
6. Click the Close button if you are done adding applications. This will close 

the window and refresh the applications. You can also continue steps 4 
through 5 to continue adding applications. 

To edit an existing application: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The list of advanced sections of the Administration tool display. 

2. Click on the Applications button on the left hand side of the Administration 
window. The list of applications appears in the right hand side. 

3. Double-click on the application you want to edit in the list in the 
Applications section. The Applications window appears. 

4. Make your changes as appropriate.  
5. Click the Save button. The Applications window closes and you see your 

changes displayed in the list. 

To delete existing applications: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The list of advanced sections of the Administration tool display. 

2. Click on the Applications button on the left hand side of the Administration 
window. The list of applications appears in the right hand side. 

3. Use a combination of CTRL-CLICK and SHIFT-CLICK to select the list of 
applications you want to delete. If you want to delete only one application, 
you can simply click on it. 

4. Click the Delete key on the toolbar at the top of the Administration 
window. A message appears asking you to confirm you want to delete the 
application(s). 

5. Click the Yes button on the message box to delete the applications. The 
bottom list refreshes to show the applications were deleted. 

Limiting the Number of Tracked Applications 

Print Audit 6 provides an extremely quick and easy way to have Print Audit limit 
tracking to only a few applications in your organization. For example, you can set 
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Print Audit to track printing only from Microsoft Word without having to add every 
other application to the Applications list. 

To limit the number of applications you want tracked: 

1. Add the applications you do want tracked to the Applications list and set 
their tracking options appropriately.  

2. Check the Track only the applications in the list button. This causes 
Print Audit to ignore printing from any application not in the Applications 
list. 

Network Settings 

Overview 

Print Audit 6 allows you to gather network user information from several different 
types of networks. Print Audit supports Novell NDS networks, Windows NT 4.0 
based networks, Active Directory networks and peer to peer Windows networks. 

You can also configure Print Audit to require users to authenticate before they 
can print or use Print Audit tools. You can choose authentication with PIN codes, 
use existing login information or require the user to re-enter their login 
information. You can even choose to have a user authenticate differently for 
printing depending on the computer they are printing from. 

Your network settings control how user information appears in Print Audit when 
users are added and imported. 

Please note that we recommend changing these settings only if you are an 
advanced user with an understanding of networks and how your network is 
implemented. 

You can do the following with this section: 

 Change your network type 
 Change how users authenticate 
 Change the PIN and PIN Password labels 
 Set the Disconnected job option per computer 
 Change the TCP/IP port the Client listens on 
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Changing Your Network Type 

Print Audit supports several different network types. Your network type controls 
how Print Audit reports user information as well as how it imports users. Your 
network type also controls how Print Audit does network authentication. 

To change your network type: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The left hand list switches to the list of advanced sections. 

2. Click on the Network and Authentication button on the left hand side of the 
Administration window. The section appears with the list of computers that 
have printed. 

3. Use the Network Type drop down to select the type of network in your 
organization.  

4. Click the Save button on the toolbar at the top of the Administration 
window to save the changes. 

Please note that the network type changes the information of new users as they 
print, it does not affect existing users. If you change the network type when you 
have existing users, the next time they print they get added to the list with the 
new network information and Print Audit treats them as different users. Please be 
aware that when these new users are added Print Audit uses your default 
tracking and security profiles. This can end up with a user under one network 
type having different rights and tracking behavior than the user under the new 
network type. 

For these reasons we highly recommend that you set the network type as early 
as possible in your Print Audit configuration and only change it if absolutely 
necessary. 

Changing How Users Authenticate 

Print Audit allows several different methods of authentication. You can configure 
Print Audit to require users to authenticate before they can print and authenticate 
before they can use the Print Audit tools. 

You can set Print Audit to require different authentication methods for printing 
(Client Authentication) and access to the tools (Tools Authentication). For 
example, you may want Print Audit to use the logged in user for tracking printing 
but require a PIN code to get into the Print Audit tools. 
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Please note that the default Client Authentication and Tools Authentication 
settings are the same as those in the Client Settings section of the Administration 
tool. We provide them there as well for ease of use. 

To change the default client authentication: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The left hand list switches to the advanced sections. 

2. Click on the Network and Authentication button on the left hand side of the 
Administration window. The section appears with the list of computers that 
have printed. 

3. Use the Default client authentication drop down to select the type of 
Client Authentication you want to do by default.  

4. Click the Save button on the toolbar at the top of the Administration 
window to save the changes. A message appears asking if you want to 
change all existing computers to use the new default. 

5. Click Yes to set all computers to the new defaults, or click No set the new 
default, but leave existing computers with their current authentication 
settings. NOTE: If you leave existing computers to "Network" 
authentication and you are using the Windows Peer to Peer network 
setting then the Client uses PIN code authentication instead. 

To change the client authentication for a computer: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The left hand list switches to the advanced sections. 

2. Click on the Network and Authentication button on the left hand side of the 
Administration window. The section appears with the list of computers that 
have printed. 

3. Double-click on the computer that you want to change authentication for. 
The Computer window appears. 

4. Use the Authentication drop down box to select the authentication type.  
5. Click the Save button on the Computer window. The Computer window 

closes and the computer list refreshes to show the changes. 

To change the tools authentication: 

1. Click on the Advanced header on the left hand side of the Administration 
window. The left hand list switches to the advanced sections. 

2. Click on the Network and Authentication button on the left hand side of the 
Administration window. The section appears with the list of computers that 
have printed. 
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3. Use the Tools authentication drop down to select the type of Tools 
Authentication you want.  

4. Click the Save button on the toolbar at the top of the Administration 
window to save the changes. 

Network Login Authentication 

For advanced users Print Audit supports network login authentication. This 
allows you to have your users enter their Windows or Novell network login 
information before they print or use the Print Audit tools. 

Using this setting on a Windows operating system has the issues that you need 
to be aware of: 

 You cannot use this setting in combination with the "Windows Peer to 
Peer" Print Audit network type. 

 Windows 98, ME computers cannot authenticate with network settings 
unless they are configured to use user-level sharing. You need to change 
this in the network settings of your Windows 9x based operating systems. 

 If you have NT based computers that are not on the domain they may not 
be able to successfully authenticate. This is because they authenticate to 
their local user database and report the domain as the computer name. 

For these reasons we recommend you only use this setting if you are running a 
Novell network or if your Windows network consists of Windows NT/Active 
Directory based operating systems that connect/authenticate to a domain. If you 
have a mixed environment we recommend using PIN code security instead. 
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Print Audit 6 Analysis Reporting 

 
 

Overview 

Welcome to Print Audit Analysis Reporting. You can use this tool to produce pre-
prepared reports for your printing volumes and costs. You can use these reports 
to determine your highest volume printers, distribution of job sizes, percentage of 
color vs black and white printing, etc. Analysis Reporting also allows you to 
create Composite Reports. These reports are a combination of several other 
reports with a title page and table of contents. 

 

This help file consists of several sections. Click the links below for information on 
each section:  

 Understanding Analysis Reporting 
 Grouping Information  
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 Creating and Removing Reports 
 Creating Composite Reports 
 Printing and Exporting Reports 
 Scheduling and Emailing Reports 

Understanding the Analysis Reporting Tool 

You can use the Analysis Reporting tool in two different modes. The normal 
mode and a "simple" mode. Simple mode in Analysis Reporting supports all of 
the same reports as the normal mode, but in simple mode you do not have 
access to complex printer and user grouping. 

The Analysis Reporting tool consists of two main areas, the toolbar and the 
tabbed display area. You use the toolbar to manipulate tabbed information or 
even create new tabs. The tabs themselves display your printer and user groups 
along with any created reports. Printer and user groups are not displayed in 
simple mode. 

There are only two tabs visible when you first run the Analysis Reporting tool in 
normal mode. They are the Printer Grouping and Filtering tab and the User 
Grouping and Filtering tab. 

The Printer Grouping and Filtering tab displays all printers in your database. 
You use this tab to arrange printers into reporting groups as well as selecting 
which printers/groups you want to include in your reports. You can also use this 
tab to enter an estimated cost per page for the printer. Generally, Analysis 
Reporting uses the actual recorded cost of the print job to calculate total costs 
when you are doing reports. If you choose, you can use the estimated cost per 
page you enter to calculate costs. IMPORTANT: Actual costs in Print Audit 
include several things such as unit type, cost modifiers, etc. Estimated cost per 
page only takes into account the reported page count. 

The User Grouping and Filtering tab displays all users in your database. You 
can use this tab to group your users any way that makes sense for your 
organization. You could group them by last name, or by department, etc.  

Once you have your groups defined you can create reports based on your data. 
After you create a report you can then print it or export it in different formats. 
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Grouping and Filtering in Normal Mode 

Analysis Grouping Information 

The Print Audit Reporting Analysis tool allows you to group your printer and user 
information together. Grouping information has two main purposes: 

 Grouping allows you to organize your printers and users in ways that 
make sense for your organization. 

 Grouping allows you to focus on high level reporting issues rather than 
individual printers. 

The last point is the most important. The main function of grouping is to allow you 
to create groups that you can display on different reports. For example, you may 
have several printers on one floor of your office. You can combine those printers 
into a group called "4th floor" and generate reports based only on those printers. 
You could also create user groups so you can report on printing costs based on 
internal departments. 

These groups are kept separate from reporting groups you can setup using 
Simple mode and the Job Manager users to give you complete flexibility in how 
you define groupings for analysis. However you can import your simple groups 
into the Analysis Reporting tool. 

To create a group: 

1. Expand the <INDIVIDUAL> group or another group you have created to 
view the contents. 

2. Click on one or more items to select them. You can use CTRL-click to 
select multiple individual items or use SHIFT-click to select a range of 
items. You can select items from more than one group at once. 

3. Click the Create/Add to Group button on the tool bar. The Create/Add to 
Group window appears. 

4. Select the option to either create a new group or move the selected items 
to an existing group. 

5. Enter your new group name or select the existing group. 
6. Click the OK button. This moves the selected items to the group you 

specified. 
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To import Administrator groups: 

1. Click the Groups->Import Simple Groups menu item. Print Audit imports 
the reporting groups from the Administrator and automatically associates 
your users and printers to those groups. If users or printers exist in 
multiple groups, they will only be associated with the first group they 
appear in. 

NOTE: This overwrites any other groups you have created. 

To delete a group: 

1. Click on the group you want to delete. You cannot delete the 
<INDIVIDUAL> group. 

2. Click the Delete Group button on the toolbar. A message box appears 
asking if you are sure you want to delete the group. 

3. Click Yes on the message box. The Analysis tool removes the group and 
moves any items in that group to the <INDIVIDUAL> group. 

To rename a group: 

1. Click on the group you want to rename. You cannot rename the 
<INDIVIDUAL> group. 

2. Click in the column that contains the name of the group. This is the 
Printer column for the Printer Information tab, the Name column for the 
User Information tab. 

3. Type the name of the new group. 

Using the Printer Grouping and Filtering Tab 

This tab shows all of the printers in the database. You use this tab to decide 
whether or not printers or groups of printers are included in reports. 

To view the contents of a printer group: 

1. Click the "plus/minus sign" at the left of the group name to 
expand/collapse the group. When expanded you can see all of the unique 
printers included in the group. 
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To group printers: 

1. Expand the <INDIVIDUAL> group or another group you have created to 
view the contents. 

2. Click on one or more printers to select them. You can use CTRL-click to 
select multiple individual printers or use SHIFT-click to select a range of 
printers. You can select printers from more than one group at once. 

3. Click the Create/Add to Group button on the tool bar. The Create/Add to 
Group window appears. 

4. Select the option to either create a new group or move the selected 
printers to an existing group. 

5. Enter your new group name or select the existing group. 
6. Click the OK button. This moves the selected printers to the group you 

specified. 

To include/exclude printers and groups from reports: 

1. Expand the <INDIVIDUAL> group or another group you have created to 
view the contents. 

2. Select the users or groups of printers you want to include/exclude. 
3. Click on the Include column or hit the SPACEBAR key to toggle the 

selection. 

Printer Grouping and Filtering Tab Columns 

 Include – This column indicates whether or not you want to include the 
printer or printer group in any reports. 

 Printer – This column contains the name of the printer or printer group. 
 Host – This column contains the host computer for the printer. The host is 

the computer which controls the printer. 
 Port – This column contains the port of the printer. For groups this is 

blank. 
 Est. Cost Per BW Page - This column contains an estimated black and 

white cost per page for the individual printer or group. Analysis Reporting 
uses this estimated cost when you create estimated cost reports. 

 Est. Cost Per Color Page - This column contains an estimated color cost 
per page for the individual printer or group. Analysis Reporting uses this 
estimated cost when you create estimated cost reports. 

 Connection - How the printer is connected to the computer/network. 
 Model – The model name of the printer. 
 Color - Whether or not the printer supports color printing. 
 Duplex - Whether or not the printer supports duplex printing. 



 

 

61 

 Company - The name of the merged company that owns this printer. Only 
displays if you have merged data in your database 

Using the User Grouping and Filtering Tab 

This tab shows all users in the database. You use this tab to decide whether or 
not users or groups of users are included in reports. 

To view the contents of a user group: 

1. Click the "plus/minus sign" at the left of the group name to 
expand/collapse the group. When expanded you can see all of the unique 
users included in the group. 

To group users: 

1. Expand the <INDIVIDUAL> group or another group you have created to 
view the contents. 

2. Click on one or more users to select them. You can use CTRL-click to 
select multiple individual users or use SHIFT-click to select a range of 
users. You can select users from more than one group at once. 

3. Click the Create/Add to Group button on the tool bar. The Create/Add to 
Group window appears. 

4. Select the option to either create a new group or move the selected users 
to an existing group. 

5. Enter your new group name or select the existing group. 
6. Click the OK button. This moves the selected users to the group you 

specified. 

To include/exclude users and groups from reports: 

1. Expand the <INDIVIDUAL> group or another group you have created to 
view the contents. 

2. Select the users or groups of users you want to include/exclude. 
3. Click on the Include column or hit the SPACEBAR key to toggle the 

selection. 
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User Grouping and Filtering Tab Columns 

 Include – This column indicates whether or not you want to include the 
user or user group in any reports. 

 Name – This column contains the name of the user or user group. 
 Domain – This column contains the name of the domain the user belongs 

to. 

Saving and Loading Groups 

Once you have setup your groups for your printers and users you can choose to 
save them to a file so you can share them with others and to make sure you do 
not have to recreate them all again. You can also setup several different 
grouping schemes and load in whatever one you need for any given situation. 

To save your grouping information: 

1. Click the Save Groups button. A dialog appears asking you for the file 
name and path. 

2. Use the dialog to choose where you want to save the group information 
file and choose a name. 

3. Click the Save button on the dialog to save the groups. 

To load your grouping information: 

1. Click the Open Groups button. A dialog appears asking you for the 
location of the grouping file you want to load. 

2. Use the dialog to find the grouping file you want to load. 
3. Click the Open button on the dialog to load the groups into memory. 

NOTE: Analysis Reporting automatically saves the groups you were working with 
in the Analysis tool when you close it down. It saves them in a file called 
"lastused.grp" in your My Documents directory. 
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Reports 

Creating and Removing Reports 

The Analysis Reporting tool comes with several different reports for both user 
and printer reporting which help you to analyze the large amounts of data that 
Print Audit collects. Each report when it displays has an information cover page. 
This page is there to remind you of what you chose when you created the report. 
You can disable this feature at any time. 

To create a report: 

1. Create any groups you want for printers and users. In normal mode, make 
sure to include only those groups you want on the report.  

2. Click the Create Report button on the toolbar. The Create or Open a 
Print Audit 6 Report window appears. 

3. Click on the Create a New Report button, or click on a previously saved 
report. 

4. Click the Ok button. If you selected a previously saved report, the report 
displays in a new tab. If you chose to create a new report, the Create a 
Report Wizard appears. The rest of these steps assume you selected to 
create a new report. 

5. Click on the type of the report you want in the reports list. The report 
highlights and a brief description of the report displays on the right. 

6. If running in simple mode, click the Next button to select a reporting group 
for printers and users. 

7. Click the Next button to select your parameters. The Parameters tab 
appears. 

8. Enter in the report parameters. There are several standard parameters, 
some reports have custom parameters.  

9. Click the Next button to enter your report titles. The Titles tab appears. 
10. Enter in any title and sub-title you want displayed on the report. 
11. Click the Build button. The wizard closes and the new report displays in a 

tab in the main reporting window. 

To create and save a report: 

1. You can save reports that you build so you can use the same report again 
and again. 

2. Follow steps 1-9 above. 
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3. Click the Build and Save button. A window appears asking you for a 
name and description you want to give to the report. 

4. Enter in the name and description for the report. 
5. Click the Save button. The window closes and your report appears in a 

tab in the main reporting window. It is also available to select the next time 
you create a report. 

To remove a report: 

1. Click the tab of the report you want to remove from the display. 
2. Click the Remove Report button on the toolbar. A message box asks you 

if you are sure you want to remove the report. 
3. Click the Yes button. Print Audit removes the report. 

To enable/disable information cover page: 

1. Click the Reports->Create Cover Page menu item. If checked, the cover 
page is printed, if not the cover page is not printed. 

Creating Composite Reports 

Print Audit allows you to create Composite reports. These are reports that 
contain several other individual reports along with a title page and table of 
contents. You can build and save composite reports to quickly generate any 
combination of reports that meet your business needs. For example you may 
want to generate Executive Summary, Printer Volumes and User Volumes report 
for month end reporting. Using Composite reports you can build this once and 
generate all three reports with one click of the mouse. 

To create a Composite report: 

1. Create any groups you want for printers and users. Make sure to include 
only those groups you want on the report. 

2. Click the Create Report button on the toolbar. The Create or Open a 
Single or Composite Report window appears. 

3. Click on the Create a New Composite Report button, or click on a 
previously saved report. 

4. Click the Ok button. If you selected a previously saved report, the report 
displays in a new tab. If you chose to create a new report, the Create a 
Composite Report Wizard appears. The rest of these steps assume you 
selected to create a new report. 
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5. Enter the general Report information on the Report Information tab. This 
includes the title you want for the report, who prepared it, the date range, 
etc.  

6. Click the Next button to go to the Select Reports tab. 
7. Select the reports you want in the Composite report on the Select 

Reports tab. Print Audit sets a default list of some of the more popular 
reports. You can add and remove reports to meet your needs. The order 
that reports appear in the Selected list is the order they will appear in the 
finished report. 

8. If in simple mode, click the Next button to go to the Groups tab. Select 
the groups you want to use for the report.  

9. Click the Next button to go to the Options tab. 
10. Select the overall report options. These options apply to every individual 

report within the Composite report.  
11. Click the Build button. The wizard closes and the new report displays in a 

tab in the main reporting window. 

To create and save a Composite report: 

1. You can save Composite reports that you build so you can use the same 
report again and again. 

2. Follow steps 1-10 above. 
3. Click the Build and Save button. A window appears asking you for a 

name and description you want to give to the report. 
4. Enter in the name and description for the report. 
5. Click the Save button. The window closes and your report appears in a 

tab in the main reporting window. It is also available to select the next time 
you create a report. 

To remove a report: 

1. Click the tab of the report you want to remove from the display. 
2. Click the Remove Report button on the toolbar. A message box asks you 

if you are sure you want to remove the report. 
3. Click the Yes button. Print Audit removes the report. 

To enable/disable information cover page: 

1. Click the Reports->Create Cover Page menu item. If checked, the cover 
page is printed, if not the cover page is not printed. This setting affects all 
reports in the Composite report. 
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Report Parameters 

When you create a report there are several standard options you can select. 
They are as follows: 

Normal Mode Only 

 Filter report data - If checked Analysis Reporting includes only those 
groups and individuals that you selected on the grouping tabs. If 
unchecked Analysis Reporting includes all groups and individuals 
regardless of your selection. 

 Group report data - If checked Analysis Reporting uses the groups you 
selected on the grouping tabs to display information. If unchecked 
Analysis Reporting does not use the groups and reports each user and 
printer individually. 

 Use Est. Costs - Use the estimated costs instead of actual costs on the 
report. If checked Analysis Reporting uses the estimated cost per page on 
the Printer Grouping and Filtering tab to calculate costs instead of the 
costs recorded in the database. If disabled then the selected support does 
not allow you to use estimated costs. 

Both Simple and Normal Mode 

 Sorting - You can choose to sort some reports in different orders. For 
example you can sort some reports by descending total page count. If 
disabled the report does not support custom sorting. NOTE: This 
parameter option is not available for Composite Reports. 

 Decimal places - You can enter the number of decimal places to use in 
costs for the report. Defaults to the number of decimal places configured 
in the Administrator. 

The Parameters section contains parameters that are specific to the report you 
selected. The most common parameter is the date range of the report. You can 
use the drop-down to select a standard date type or enter a complete custom 
date for the report. 

Printing and Exporting Reports 

Once you create the report you want you can choose to print it to your printer or 
export it to one of our supported formats. 
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To print a report: 

1. Click on the tab of the report you want to print. If you have not created any 
reports, see Creating and Removing Reports. 

2. Click the Print Report button on the toolbar. A dialog appears that allows 
you to select the printer. 

3. Select the printer to which you want to print the report. 
4. Click the Print button. The report will print to your printer. 

To export a report: 

1. Click on the tab of the report you want to export. If you have not created 
any reports, see Creating and Removing Reports. 

2. Click the Export Report button on the toolbar. A dialog appears that 
allows you to select the export format and the path for the exported file. 

3. Use the Save as type drop down box to select the type.  
4. Use the dialog to select the directory where you want to export the file, 

and type the name. 
5. Click the Save button. The analysis tool creates the report in the format 

you chose. 

Scheduling and Emailing Reports 

Using Analysis Reporting you can schedule report creation and automatically 
email a PDF of the report to one or more recipients. IMPORTANT: Before Print 
Audit can email a report, you must properly configure the email settings in the 
Global Settings section of the Administration tool. 

To schedule a report: 

1. Create a new or run an previously saved report.  
2. Click the Schedule Report button on the toolbar. The Schedule a Report 

Window appears. 
3. Set how often you want the report to run, and set who you want to email 

the report to.  
4. Click the Schedule button. Analysis Reporting creates an entry in the 

Windows Task Scheduler for the report. 
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To edit scheduled reports: 

1. Click the View Scheduled Reports button on the toolbar. The Scheduled 
Reports Window appears. 

2. A list of all scheduled reports displays, giving scheduling information and 
the last time the report was successfully run. 

3. Click on the report you want to edit in the list, and click the Edit button. 
The Schedule a Report Window appears. 

4. Make your changes, and click the Schedule button. The Schedule a 
Report Window closes. 

5. Click the Close button on the Scheduled Reports Window. 

To delete scheduled reports: 

1. Click the View Scheduled Reports button on the toolbar. The Scheduled 
Reports Window appears. 

2. A list of all scheduled reports displays, giving scheduling information and 
the last time the report was successfully run. 

3. Click on the report you want to delete in the list, and click the Delete 
button. A message appears asking you to confirm that you want to delete 
the scheduled report. NOTE: Deleting a scheduled report only deletes the 
scheduling, it does not delete a saved report definition. 

4. Click the Yes button to delete the scheduled report. 
5. Click the Close button on the Scheduled Reports Window. 

Report Export Formats 

Analysis Reporting supports several different formats to which you can export 
your reports. They are as follows: 

 Text File – This exports the report to a flat text file. Columns are tab-
delimited which can be imported into Excel. 

 HTML Page – This exports the report to an HTML (web page) format you 
can then put on a website. 

 PDF File – This exports the report to an Adobe PDF file format to send to 
others. 
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 Raw Data – This exports the underlying data of the report to a comma-
delimited file. NOTE: The information exported may not correspond 
exactly to what you see in the report. For example, some totals and other 
calculations may not be in the data. This is due to the fact that some sub 
totaling and translation take place in the reporting engine. 

 

Print Audit 6 Job Manager 

 

Welcome 

Welcome to the Print Audit 6 Job Manager. You use this tool to manage your 
detailed print job information. 

You can search for jobs using several different pieces of search criteria. Once 
you find the jobs you want you can edit the jobs, build reports based on the job 
details and export the job information. 

You can also use the Job Manager to schedule exports of your job information to 
a file format that your accounting program can read. 
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Click on the links below for more information on how to use the Job Manager: 

 Searching for jobs 
 Changing how you view the data 
 Editing and deleting your jobs 
 Creating, printing and exporting reports 
 Scheduling and Emailing Reports 
 Exporting jobs 
 Exporting jobs for Accounting 

 For advanced users: 

 Using the Job Manager with merged jobs 
 Securing the Job Manager 

Finding, Viewing and Editing Jobs 

Searching for Print Jobs 

One of the first steps in using the Job Manager is to find the job or jobs you want 
to act on. Print Audit allows you to search for jobs based on a combination of 
criteria. 

We highly recommend that you narrow your search as much as possible. Print 
Audit can track thousands of print jobs per day depending on the printing 
volumes in your organization. 

You can search for jobs based on the following: 

 Date Printed - You can specify the date range in which the jobs you want 
were printed. You can select from one of the standard date ranges, or 
select Custom from the drop-down to enter your own custom date. Print 
Audit always uses a date range for the search. 

 User who printed - Use the drop down to select the user you want to 
search on. You can also type the first few characters of the user name to 
have Print Audit find all matching users. Click the Match on Reporting 
group option to have Print Audit match on a reporting group you select 
rather than a user name. Click here for more information on reporting 
groups. If you leave this blank, Print Audit finds jobs for all users. Please 
note that you can only select users if you have access to view all print job 
data.  
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 Printer used - Use the drop down to select the printer you want to search 
on. You can also type the first few characters of the printer name to have 
Print Audit find all matching printers. Click the Match on Reporting group 
option to have Print Audit match on a reporting group you select rather 
than a printer name. Click here for more information on reporting groups. If 
you leave this blank, Print Audit finds jobs for all printers. 

 Custom Fields (Recovery only) - If you have defined custom fields to 
display on the Client Popup window, then you can search on specific 
custom field values for each custom field you defined. 

To search for print jobs: 

1. Enter your criteria as described above. 
2. Click the Find Jobs button on the toolbar. A list of all matching jobs 

displays in a list below the search criteria. 

Once you have a list of jobs, you can do several things. Click the links below 
for more information: 

 Create reports 
 Edit jobs 
 Export jobs 

Changing Your Data View 

The Print Audit Job Manager allows you to configure the way you view the 
columns of information in the job results lists. You can show and hide individual 
columns, re-arrange the columns and sort on the column information. 

Once you get the columns arranged to suit your needs, you can save the 
configuration and give it a name. You can create multiple configurations this way 
and easily switch between them. 

Please note that you must have searched for and found jobs before you can 
adjust a view.  
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To show and hide columns: 

1. Right-click on any column header. The Columns in View window 
appears. 

2. Check the box to the left of a column name to display the column, or clear 
the check box to hide the column. 

3. Click the OK button once you have the arrangement you want. The 
Columns in View window closes and the list updates. 

To re-size a column: 

1. Move the mouse cursor until it is on the right-hand edge of the column 
header for the column you want to resize. The cursor changes to resize 
mode. 

2. Click and hold the left mouse button and drag the column edge to the left 
to make the column smaller or to the right to make it larger. 

3. Release the mouse button once column is the size you want. The column 
resizes to the new size. 

To re-size all columns to fit: 

1. Click the Edit->Size Columns To Fit menu item. Print Audit resizes all 
displayed columns to fit the data displayed in the columns. Please note 
that this can take several seconds depending on the number of jobs in the 
list. 

To move a column: 

1. Click and hold the left mouse button on the column header of the column 
you want to move. 

2. Move the mouse right to move the column to the right, left to move the 
column to the left. You should see an outline showing you where the 
column will end up. 

3. Release the mouse button once the column is in the position you want. 
The column moves to the new position. 

To sort on a column: 

1. Click on the column header of the column you want to sort. An arrow 
appears in the column header indicating the sort order. Click again to 
change the sort order. 
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To save your data view: 

1. Click the Save Data View button on the toolbar. A dialog appears asking 
you to enter the name of the new view. 

2. Enter the name you want to call the view.3. 
3. Click the OK button on the dialog. The dialog closes and the new view 

appears in the Views drop down in the toolbar. Please note that if you 
enter the same name as an already existing view Print Audit overwrites 
the old view. 

To select a previously saved data view: 

1. Click on the Views drop down in the toolbar. A list of all previously saved 
views appears. 

2. Click on the view you want. The results view changes to the new view. 

To delete a previously saved data view: 

1. Select the data view you want to delete as described in the previous 
section. 

2. Click the Delete View button on the toolbar. Print Audit deletes the view 
and switches to the default view. 

Editing and Deleting Jobs 

You can use Print Audit 6 to edit existing print jobs. Once you print a job you may 
want to adjust the job costs, view the detailed job information or delete the jobs. 

You can control who has permission to edit and delete jobs.  

To edit/view a print job: 

1. Search for the job you want to edit.  
2. Double-click on the job you want to edit. The Print Job Window appears. 
3. Make changes to the job if appropriate. Please note that not all fields are 

editable.  
4. Click the Save button to exit and save any changes or click the Cancel 

button to close the window. 
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To delete individual print jobs: 

1. Search for the job you want to delete.  
2. Click on the job you want to delete. The job highlights.  
3. Click the Delete Current Job on the toolbar to delete the highlighted job. 

A dialog appears asking if you are sure you want to delete the job. 
4. Click Yes to delete the job from the database. The list refreshes to show 

the results. 

To delete an entire list of jobs: 

1. Search for the jobs you want to delete.  
2. Click the Edit->Delete All Jobs in List menu item. A dialog appears 

asking you to confirm that you want to delete all the jobs in the list. 
3. Click Yes to delete all the jobs in the list. 

Job Reporting 

Job Manager Reports 

The Print Audit 6 Job Manager allows you to quickly build custom reports based 
on the jobs in your database. Once you design a report you like you can save the 
report definition so you can easily create it again. You can also schedule and 
email your reports to other users. 

You can only create reports that deal with the specifics of your print job 
information. For reports designed for in-depth analysis of your printing 
information you can use the Print Audit Analysis Reporting tool. 

You can use the Job Manager to create three types of reports: 

 Summary Report - This report allows you to report on total job costs and 
volumes, including grand totals. 

 Full Report - This report allows you to report detailed information along 
with a breakdown of total job costs and volumes, including grand totals. 

 Detail Report - This report allows you to report detailed print job 
information in a sorted format but with no totaling. 

Once you create the report you want it displays in its own tab in the Job Manager 
window. You can then print it to a printer or export it to PDF or HTML formats. 
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After you are done viewing, printing or exporting your report you can click on the 
Remove Report button on the toolbar to close it. 

Click the links below for step-by-step instructions on building, printing and 
exporting reports: 

 Creating a Report 
 Printing and Exporting Reports 
 Scheduling and Emailing Reports 
 How to Create a Billing Statement 

Creating Reports 

Please follow the steps below to quickly create reports based on your print jobs.  

To create a Summary report: 

1. Search for the jobs you want to include on the report.  
2. Click the Create a new Report button on the toolbar. The Build a 

Report wizard appears. 
3. Click on Summary (Totals Only) in the reports list on the left. A 

description of the report appears on the right. 
4. Verify that the number of decimal places you want for the report is 

correct. 
5. Click the Next button. The wizard changes to the Total By tab. 
6. Select the columns to total on. You can select up to three columns to 

total on. For example, you could select User, Printer and Color to get 
totals for each user broken down by printer and color. 

7. Click the Next button. The wizard changes to the Totals and Breaks 
tab. 

8. Select the unit type you want to display for the unit totals. 
9. Check the Show job cost totals to display cost totals on the report, 

broken down by your Total By selection. 
10. Check the Show job count totals to display the total number of jobs on 

the report, broken down by your Total By selection. 
11. Check the Subtotal and Page break check boxes to set or clear 

subtotaling and page breaks by level. 
12. Click the Next button. The wizard changes to the Titles tab. 
13. Enter in an optional title and sub-title you want displayed at the top of 

each page in the report. If you want to display the From and To date 
used in the title when the report prints, you can enter the %from and %to 
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placeholders in the title. For example:  "My report with data from %from 
to %to". 

14. Click the Build button to build and display the report. If you want to keep 
this report definition to re-run later, you can click Save and Build to 
enter a name and description for your new report definition. If you save a 
report definition it displays in the list of available reports the next time 
you run the Build a Report wizard. 

To create a Full report: 

1. Search for the jobs you want to include on the report.  
2. Click the Create a new Report button on the toolbar. The Build a Report 

wizard appears. 
3. Click on Full (Details and Totals) in the reports list on the left. A 

description of the report appears on the right. 
4. Verify that the number of decimal places you want for the report is correct. 
5. Click the Next button. The wizard changes to the Fields tab. 
6. Select up to five fields to display in the report. These fields appear as 

columns on the finished report. 
7. Click the Next button. The wizard changes to the Total By tab. 
8. Select the columns to total on. You can select up to three column to total 

on. For example, you could select User, Printer and Color to get totals for 
each user broken down by printer and color. 

9. Click the Next button. The wizard changes to the Totals and Breaks tab. 
10. Select the unit type you want to display for the unit totals. 
11. Check the Show job cost totals to display cost totals on the report, 

broken down by your Total By selection. 
12. Check the Show job count totals to display the total number of jobs on 

the report, broken down by your Total By selection. 
13. Check the Subtotal and Page break check boxes to set or clear 

subtotaling and page breaks by level. 
14. Click the Next button. The wizard changes to the Titles tab. 
15. Enter in an optional title and sub-title you want displayed at the top of each 

page in the report. If you want to display the From and To date used in the 
title when the report prints, you can enter the %from and %to placeholders 
in the title. For example:  "My report with data from %from to %to". 

16. Click the Build button to build and display the report. If you want to keep 
this report definition to re-run later, you can click Save and Build to enter 
a name and description for your new report definition. If you save a report 
definition it displays in the list of available reports the next time you run the 
Build a Report wizard. 
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To create a Details Only report: 

1. Search for the jobs you want to include on the report.  
2. Click the Create a new Report button on the toolbar. The Build a Report 

wizard appears. 
3. Click on Details Only in the reports list on the left. A description of the 

report appears on the right. 
4. Verify that the number of decimal places you want for the report is correct. 
5. Click the Next button. The wizard changes to the Fields tab. 
6. Select up to five fields to display in the report. These fields appear as 

columns on the finished report. 
7. Click the Next button. The wizard changes to the Sort By tab. 
8. Select the columns to sort. You can select up to three column to sort by. 

Please note that you must have selected these columns on the Fields tab. 
9. Click the Next button. The wizard changes to the Titles tab. 
10. Enter in an optional title and sub-title you want displayed at the top of each 

page in the report. If you want to display the From and To date used in the 
title when the report prints, you can enter the %from and %to placeholders 
in the title. For example:  "My report with data from %from to %to". 

11. Click the Build button to build and display the report. If you want to keep 
this report definition to re-run later, you can click Save and Build to enter 
a name and description for your new report definition. If you save a report 
definition it displays in the list of available reports the next time you run the 
Build a Report wizard. 

Printing and Exporting Reports 

Once you create a report you can either print the report or export it to a different 
file format. Please follow the steps below to print and export your reports. 

To print a report: 

1. Create the report you want. If already created, click on the tab containing 
the report you want to print. 

2. Click the Print Report button on the toolbar. A dialog appears asking you 
to select your printer. 

3. Select the printer and click the Print button. The dialog closes and Print 
Audit sends your report to the printer. 
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To export a report: 

1. Create the report you want. If already created, click on the tab containing 
the report you want to print. 

2. Click the Export Report button on the toolbar. A dialog appears asking 
you to select the export type and the file name. 

3. Use the Save as type drop down box on the dialog to select the export 
type. You can select from PDF and HTML formats. 

4. Click the Save button. Print Audit saves the report to the file you specified. 

Scheduling and Emailing Reports 

Using the Job Manager you can schedule report creation and automatically email 
a PDF of the report to one or more recipients. IMPORTANT: Before Print Audit 
can email a report, you must properly configure the email settings in the Global 
Settings section of the Administration tool. 

To schedule a report: 

1. Create a new or run a previously saved report. NOTE: You cannot 
schedule reports based on the "All" date range. You must choose a 
different option. 

2. Click the Schedule Report button on the toolbar. The Schedule a Report 
Window appears. 

3. Set how often you want the report to run, and set who you want to email 
the report to.  

4. Click the Schedule button. Analysis Reporting creates an entry in the 
Windows Task Scheduler for the report. 

To edit scheduled reports: 

1. Click the View Scheduled Reports button on the toolbar. The Scheduled 
Reports Window appears. 

2. A list of all scheduled reports displays, giving scheduling information and 
the last time the report was successfully run. 

3. Click on the report you want to edit in the list, and click the Edit button. 
The Schedule a Report Window appears. 

4. Make your changes, and click the Schedule button. The Schedule a 
Report Window closes. 

5. Click the Close button on the Scheduled Reports Window. 
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To delete scheduled reports: 

1. Click the View Scheduled Reports button on the toolbar. The Scheduled 
Reports Window appears. 

2. A list of all scheduled reports displays, giving scheduling information and 
the last time the report was successfully run. 

3. Click on the report you want to delete in the list, and click the Delete 
button. A message appears asking you to confirm that you want to delete 
the scheduled report. NOTE: Deleting a scheduled report only deletes the 
scheduling, it does not delete a saved report definition. 

4. Click the Yes button to delete the scheduled report. 
5. Click the Close button on the Scheduled Reports Window. 

How to Create a Billing Statement 

To create a billing statement style report in the Job Manager you first need to 
search for the jobs you want to bill for, and then generate the report. This 
example leads you through creating a detailed billing statement for the previous 
month. The example also assumes that you have a custom field called "Client" 
that contains codes used that correspond to the client you are billing. See 
detailed steps below. 

1. Open the Print Audit 6 Job Manager. 
2. Use the Date Printed drop-down box to select a date range for the jobs 

you want to bill for. For this example select "Last Month" from the drop-
down. 

3. You can choose to narrow down the report to one specific "Client" or all 
clients in the database. If you want to narrow down the client select the 
appropriate one from the Client drop-down. Please remember that we 
are assuming you have a "Client" custom field defined for this example, 
you can choose to narrow down the search based on any custom field you 
define. 

4. Click the Find Jobs button on the toolbar.  A list of jobs that match your 
search criteria appear. 

5. Click on the Create Report button on the toolbar.  The Build a Report 
wizard appears. 

6. Select the level of detail you want in the report. Since we want to produce 
a detailed billing statement, click the "Full (Details and Totals" option. 

7. Click the Next button.  The wizard moves to the Fields tab. 
8. Double-click the fields in the left hand list you want to include on the 

report. They move to the right hand side. For this example include 
Document name, Date Printed, Total Units and Total Cost. 
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9. Click the Next button. The wizard moves to the Total By tab. 
10. Use the 1st choice, 2nd choice and 3rd choice drop down boxes to 

select fields you want to total on. For this example select your "Client" 
custom field for the first choice and "Color" for your second choice. Leave 
the third choice blank. This will calculate totals on the report for each client 
and further break it down by color vs black and white jobs. 

11. Click the Next button. The wizard moves to the Totals and Breaks tab. 
12. Use the Unit Totals drop down to select "Pages". This will show all totals 

in pages. 
13. Check the Show job cost totals box to display a sub-total of job costs for 

each client. 
14. Click the Next button. The wizard moves to the Titles tab. 
15. Enter in an appropriate title and sub-title. For this example a title of 

"Monthly Billing Statement" may be appropriate. 
16. Click the Build or the Build and Save button. Both will build the report, 

but Build and Save also saves this report definition so that you can re-run 
the exact report any time you want. Once Print Audit builds the report it 
appears in a tab in the main Job Manager window. 

17. Use the Print Report button on the toolbar to print your new report or 
Export Report button to save the report in different formats. 

Job Exporting 

Exporting Jobs 

The Job Manager allows you to export your print jobs to several different 
formats. You can then use this file in third-party accounting or reporting tools to 
give you even more job processing options. For example, you could export your 
jobs to a standard comma-delimited format to allow you to open the jobs in 
Microsoft Excel for detailed analysis. 

 
When you export jobs you generally need to select an export type and an export 
configuration. The export type determines how Print Audit will export the jobs. 
For example, the Flat File export type exports your information to a standard 
text file. 

 
The export configuration determines the format and options of the export type. 
For example you could create a Flat File export that only exports five columns 
of data in a tab-delimited format. 

 
You can export jobs in one of three ways. Click on the links below for more 
information: 
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 Export Current Results - This allows you to choose the export type and 

configuration you want to use to export all jobs in your current results list. 
 Export Current View - This allows you to quickly export all jobs in your 

current results list to a comma-delimited file that mirrors how you have 
constructed your current data view. 

 Run Accounting - This allows you to choose the export type and 
configuration you want to use to export all jobs in your database if they 
have not already been exported for accounting. This export type does not 
take into account any of your job search criteria. 

 
Print Audit currently supports only Flat File exports.  

Accounting 

Job Type Account Codes 

 
Print Audit 6 allows you to define custom account codes for different 
job/transaction types. For example you could assign a different accounting code 
to Print jobs versus Copy jobs. 
 
You can then choose to export these account codes with your other job 
information to make integration into your accounting data easier. 
 
To setup transaction codes: 

 
1. Click the Accounting->Edit Job Type Account Codes menu item. 

The Edit Job Type Account Codes window appears. 
2. Click in the Code column for the job type you want to change. 
3. Type the new account code in the column. 
4. Repeat 2-3 to change codes for all the transaction types. 
5. Click the Save button. The Edit Job Type Account Codes window 

closes. 

Running Accounting Exports 

This export type allows you to export any non-accounted jobs to an export type 
you specify.  
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To export for accounting: 
 

1. Click the Accounting->Run Accounting menu item. The Export Jobs 
window appears. 

2. Select the type of export you want to do from the Export type drop 
down box. Currently your options may only include a Flat File Export. 
New types of exports may be available in the future. 

3. Select the configuration you want from the Configuration drop down. If 
you have not defined a custom configuration you only have the 
<Default> configuration.  

4. Click the Export button to export your information. Depending on your 
export configuration you may have to select a file name or enter other 
information. Once done Print Audit exports your jobs for accounting. 

 
You can also have Print Audit run an export on a scheduled basis. You may 
also need to re-do accounting runs.  

Clearing Accounting Runs 

In some cases you may need to clear previous accounting runs. For example a 
file could get lost, or some error could occur with your accounting system that 
requires you to re-export jobs for accounting. The Job Manager allows you to 
clear any accounting run.  
 
To clear an accounting run: 
 

1. Click the Accounting->Accounting Runs menu item. The Clear 
Accounting Runs window appears. 

2. Click on the accounting run you want to clear in the list. 
3. Click the Clear button. A dialog displays asking you if you are sure you 

want to clear the run. 
4. Click the Yes button. Print Audit marks all the jobs in the run as ready to 

export. The next time you run accounting all jobs that were in the cleared 
run will export. 
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Scheduling Accounting Exports 

Using the Job Manager you can schedule accounting exports to run daily, 
weekly or monthly. You can use this functionality to automate the importing of 
your print job information into an accounting system.  
Print Audit integrates with the Microsoft Windows Task Scheduler. Advanced 
users can use the task scheduler directly to further customize how the export 
runs. 
 
IMPORTANT: Before you can schedule an accounting run you must create a 
Print Audit user with rights to run accounting and assign them a PIN code.. 
 
To schedule an accounting export: 
 

1. Click the Accounting->Run Accounting menu item. The Export Jobs 
window appears. 

2. Select the type of export you want to do from the Export type drop 
down box. Currently your options may only include a Flat File Export. 
New types of exports may be available in the future. 

3. Select the configuration you want from the Configuration drop down. If 
you have not defined a custom configuration you only have the 
<Default> configuration.  

4. Use the Run Export drop down to select how often to run the export. 
Choices are Daily, Weekly or Monthly. 

5. Use the On drop down to select the day on which to run the export. 
This is only effective for Weekly or Monthly schedules. 

6. Use the At selector to select the time of day at which to run the export. 
We recommend using a time outside of regular business hours. 

7. Click the Schedule button. The Accounting Run PIN Code window 
appears. 

8. Enter the Print Audit PIN code of someone authorized to export all job 
information.  

9. Click the OK button. If the PIN code is valid Print Audit stores the 
settings you entered and creates the task. 

 
To un-schedule an accounting export: 

 
1. Click the Accounting->Run Accounting menu item. The Export Jobs 

window appears. 
2. Select the type of export you want to do from the Export type drop 

down box. Currently your options may only include a Flat File Export. 
New types of exports may be available in the future. 
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3. Select the configuration you want to remove from the Configuration 
drop down. 

4. Click the Unschedule button to remove the task. 
 

You can also use the Windows Task Scheduler interface directly to remove   
scheduled runs. 

Advanced 

Job Manager and Merged Jobs 

You can use the Job Manager to view jobs from a merged Print Audit database. 
Print Audit 6 allows you to merge jobs from multiple companies into one 
database. For more information on how to merge jobs, please see the 
documentation on the Print Audit Job Merge Wizard. 

If you have jobs from multiple companies in the database you can choose to view 
any one of the company's data or view all companies at once. 

To change the company: 

1. Click the Company drop down in the toolbar. A list of all available 
companies appears. 

2. Select the company you want to view. The Job Manager clears any 
existing job results and any reports. 

3. Search for the jobs you want for the new selection.  

NOTE: When exporting for accounting, Print Audit exports jobs from ALL 
companies regardless of any company selection in the Job Manager. 

Securing the Job Manager 

Print Audit allows you to define several different levels of security for the Job 
Manager.  You can also choose to have users enter a PIN code or their network 
login information before they can use the Job Manager. 

Before you can schedule accounting exports you must enter the PIN code of a 
user who has the rights to run accounting. Print Audit needs this to ensure that 
your job information is secure as possible. You can choose to enter a PIN code 
of an existing user or use the Administration tool to create a new user that has 
run accounting rights. 
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 All security settings in Print Audit are controlled through the Print Audit 5 
Administration tool. Please see the topics on Security Profiles and Authentication 
in the Administration help for more information on security. 

   Here is a list of the policies you can set in the Security Profile that affect the Job 
Manager: 

 User can view their own print job data - A user with this policy can view, 
export and print only their print job information. 

 User can view all print job data - A user with this policy can view, export 
and print all print job information. 

 User can edit existing print jobs - A user with this policy can edit jobs in 
the Job Manager. 

 User can run accounting - A user with this policy can run and clear 
accounting exports. 

If a user does not have any of these policies in their security profile then they 
cannot use the Print Audit Job Manager. 

Print Audit 6 Job Merge Wizard 
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Welcome 

Welcome to the Print Audit 6 Job Merge Wizard. You can use the Job Merge 
Wizard to merge data from multiple databases into one database. You can report 
on this data by individual sites that you have merged, or on a global basis. 

Job merging is a two step process. First you use the Job Merge Wizard to export 
the jobs from one database to a file on your computer. Then you can use the Job 
Merge Wizard to import that file into another database. 

This capability is useful for deployments to large organizations with multiple sites. 
You can export job data from satellite sites, and imported it into a centralized 
database. This makes centralized reporting possible. The Job Merge Wizard is 
not meant as a database backup tool, or as a tool to copy databases.  

Print Audit supports this database merging through the use of "companies". Each 
database starts with one and only one "company", the one that corresponds to 
your organization. As you merge separate sites in you need to assign each to a 
separate company. This way you can easily keep track of which information 
came from where, and you do not impact your own data. 

Please click the links below for more information on using the Job Merge Wizard: 

 General usage 
 Before you Begin 
 Importing job data 
 Scheduling job imports 
 Exporting job data 
 Scheduling job exports 

Requirements 

To use the Job Merge Wizard the user must have Print Audit Administration 
rights. There are additional requirements to setup scheduled imports and 
scheduled exports: 

1. The Windows Scheduling Service must be running. This service is 
included as part of Windows98 and newer operating systems.  

2. You must have administrative privileges on the computer where the 
Wizard is being run.  



 

 

87 

3. Before you can schedule job exporting and importing you must create a 
Print Audit user with Print Audit Administrator rights and assign them a 
PIN code. You are asked for this PIN code during the final step of the 
wizard.  

Before You Begin 

Merge Codes 

Print Audit uses merge codes to allow you to import data from a large number of 
databases. The merge codes uniquely identify jobs and custom field values so 
you can keep track of where the merged data came from. You should decide on 
your merge codes before using the tool for the first time. 

When exporting data from your database you need to enter an export merge 
code. You can choose any code you find easy to remember. You enter this code 
as the "Job Merge Code" when exporting data or setting up a scheduled export. 

When importing the data (or setting up scheduled imports) you need to create a 
company that has the same merge code that was used when the data was 
exported. All the data imported with this merge code will be entered in the 
database under this company. 

 When exporting and importing custom field values you can specify a merge code 
for each field. The merge codes on the import side must match merge codes on 
the export side for everything to import correctly. 

 For example: 

Suppose you have two offices using Print Audit. Your office is the "head" office. 
The other office is a "branch" office. You do not want to import custom fields. If 
you want to merge the branch office data into Print Audit you would need to do 
the following steps: 

1. Choose a merge code for your branch office data. For this example use 
"branch001". 

2. At the branch office, export the data using the Job Merge Wizard. Make 
sure to use the "branch001" code as the merge code. 

3. Send the job file created in step 2 to the head office. You can send the file 
via email, ftp, WAN or any other way that makes sense for your 
organization. 
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4. At the head office, import the data using the Job Merge Wizard. Make sure 
you create a company with the "branch001" code on the Merge Codes tab 
of the import. 

5. Import the data. All of the branch office data is now in the same database 
as the head office. You can use the Print Audit Job Manager and other 
tools to view and report on the data. 

Performance 

We recommend using SQL Server if importing jobs into your database. SQL 
Server can handle much larger volumes of data than Microsoft Access and can 
do so much more efficiently.  

You can export from Microsoft Access and SQL Server, but if dealing with large 
volumes of data we highly recommend SQL Server. 

If you do not have SQL Server in your organization you can also use Microsoft's 
SQL Express. Please go to Microsoft's website for more information on SQL 
Express. 

General Usage 

The Job Merge Wizard user interface guides you through the process of 
importing or exporting Print Audit 6 job data. At the top of the window for each 
step in the wizard is a help note. This note gives you a brief description of the 
information you need to provide. 

Immediately below the help reminder is a list of tabs. This list grows as you use 
the wizard and contains all the steps that you have already completed along with 
the current and next steps. At any time you can click on a tab to view its contents 
and change any of the information. Some changes can cause the list of tabs to 
change. 

Each tab contains information you need to complete before you can proceed to 
the next step.  

Along the bottom of window are four buttons. The back and next buttons move 
you to the previous and next step in the process, respectively. Once you 
complete the final step, you use the Finish button to complete the Wizard. At any 
time, you can click the Cancel button to exit the Wizard without completing it. If 
cancelled, no data is imported or exported. 
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Importing 

Importing Job Data 

To import data, the Wizard guides you through the following 5 steps. 

Step 1: Start 

Select Import Jobs Now and click Next. The wizard moves to the Database tab. 

Step 2: Import Into Database 

Review the currently selected database. Print Audit imports the jobs into this 
database. If you want to import data into a different database, click Change 
Database. Once you are satisfied with your database selection, click Next. The 
wizard moves to the Import Settings tab. 

Step 3: Job Import Settings 

Choose Import Jobs Only to ignore any custom field values in the import file, or 
click Import Jobs and Custom Fields to import custom field information along 
with the job information. NOTE: For the custom fields to import correctly the 
merge codes for the custom fields in the import file MUST MATCH the merge 
codes for your custom fields. 

Choose Duplicate records overwrite existing records to overwrite a job in 
your database if it exists in both the file and the database. Choose Duplicate 
records are ignored if you want to ignore jobs that exist in both the file and the 
database. 

Enter a company name to use for non-imported print jobs. This can simply be 
your company name, or something like "Head Office". This allows you to easily 
distinguish between imported jobs and those jobs Print Audit tracked directly to 
the database. In Step 4 you will set up company names for the data you are 
importing. 

Once you have decided and made the appropriate selections, click Next. The 
wizard moves to the Merge Codes tab. 
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Step 4: Merge Codes 

You use this tab to add or update the merge codes. The Job Wizard uses merge 
codes to properly match jobs with companies and to match custom fields.  

At minimum you must set up a company and corresponding merge code. Double-
click an empty row in the Companies grid, and enter in the name of the company 
and the merge code. The merge code you enter MUST MATCH the merge code 
used when the jobs you are importing were exported. The company name you 
enter displays when reporting on the data. 

You can create as many companies as you need. Generally you need to create 
one company for each database you import data from. If you do regular imports 
of data from two other databases you need to set up two companies, each with a 
different merge code. 

If you choose to import custom field values in the previous step you also need to 
set up merge codes for the custom fields at this time. Enter in merge codes for 
custom fields that you want to import data into. These merge codes must match 
merge codes specified for the custom fields when the data was exported. 

Note that unlike job data, imported custom field data becomes a direct part of the 
database. New custom field values that were imported will show up as options for 
Print Audit Clients which report directly to this database. 

Once you have provided the merge codes, click Next. The wizard moves to the 
Import From File tab. 

Step 5: Import from File 

Choose the file you wish to import data from. This file will normally have a .jbs 
extension. Choose the file and click Finish. Print Audit starts importing your data. 
Please note that this can take several minutes depending on the amount of data 
being imported. 

Setting up Scheduled Imports 

To set up scheduled imports, the wizard guides you through the following 5 
steps. Please note that there are additional requirements to set scheduled 
imports and exports. 
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Step 1: Start 

Select Setup Scheduled Import and click Next. The wizard moves to the 
Database tab. 

Step 2: Import Into Database 

Review the currently selected database. Print Audit imports the jobs into this 
database. If you want to import data into a different database, click Change 
Database. Once you are satisfied with your database selection, click Next. The 
wizard moves to the Import Settings tab. 

Step 3: Job Import Settings 

Choose Import Jobs Only to ignore any custom field values in the import file, or 
click Import Jobs and Custom Fields to import custom field information along 
with the job information. NOTE: For the custom fields to import correctly the 
merge codes for the custom fields in the import file MUST MATCH the merge 
codes for your custom fields. 

Choose Duplicate records overwrite existing records to overwrite a job in 
your database if it exists in both the file and the database. Choose Duplicate 
records are ignored if you want to ignore jobs that exist in both the file and the 
database. 

Enter a company name to use for non-imported print jobs. This can simply be 
your company name, or something like "Head Office". This allows you to easily 
distinguish between imported jobs and those jobs Print Audit tracked directly to 
the database. In Step 4 you will set up company names for the data you are 
importing. 

Once you have decided and made the appropriate selections, click Next. The 
wizard moves to the Merge Codes tab. 

Step 4: Merge Codes 

You use this tab to add or update the merge codes. The Job Wizard uses merge 
codes to properly match jobs with companies and to match custom fields.  

At minimum you must set up a company and corresponding merge code. Double-
click an empty row in the Companies grid, and enter in the name of the company 
and the merge code. The merge code you enter MUST MATCH the merge code 



 

 

92 

used when the jobs you are importing were exported. The company name you 
enter displays when reporting on the data. 

You can create as many companies as you need. Generally you need to create 
one company for each database you import data from. If you do regular imports 
of data from two other databases you need to set up two companies, each with a 
different merge code. 

If you chose to import custom field values in the previous step you also need to 
set up merge codes for the custom fields at this time. Enter in merge codes for 
custom fields that you want to import data into. These merge codes must match 
merge codes specified for the custom fields when the data was exported. 

Note that unlike job data, imported custom field data becomes a direct part of the 
database. New custom field values that were imported will show up as options for 
Print Audit Clients which report directly to this database. 

Once you have provided the merge codes, click Next. The wizard moves to the 
Scheduling tab. 

Step 5: Job Import Schedule 

Set up either a daily, weekly, or monthly import schedule using the controls at the 
top of the tab. Enter a Print Audit PIN code that has Print Audit Administration 
privileges. Finally select the directory that contains the files to import. 

Every time the schedule executes Print Audit imports all newly exported data 
files. Files already imported are ignored. The schedule simply controls how often 
Print Audit checks the directory. 

When you are satisfied with your schedule, click the Finish button. At this time 
Print Audit confirms your PIN code and saves the schedule. If your PIN code is 
incorrect, you will be prompted to change it. 
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Exporting 

Exporting Job Data 

To export data, the Wizard guides you through the following 5 steps. 

Step 1: Start 

Select Export Jobs Now and click Next. The wizard moves to the Database tab. 

Step 2: Export From Database 

Review the currently selected database. The Wizard exports the jobs from this 
database. If you want to export data from a different database, click Change 
Database. Once you are satisfied with your database selection click Next. The 
wizard moves to the Export Settings tab. 

Step 3: Job Export Settings 

Click Export Jobs Only to export only job data from the database or click 
Export Jobs and Custom Fields to export job and custom field information. 

Click Export New Jobs to export jobs printed since the last time you exported 
jobs or click Export All Jobs in Database to export all of the jobs. 

Once you have made your choices, click Next. The wizard moves to the Merge 
codes tab. 

Step 4: Merge Codes 

You use this tab to add or update the merge codes. The Job Wizard uses merge 
codes to properly match jobs with companies and to match custom fields.  

You must specify a merge code for the jobs you export. When these jobs are 
exported this merge code matches to one entered on the import side. 

If you are including custom field values in your export, set up merge codes for the 
custom fields you wish to export. Double click on the Custom Field Merge Codes 
grid to the right of the custom field name to enter in a merge code. 

If you leave the merge code for a field blank, it will not be exported. 
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Once you enter the merge codes click Next. The wizard moves to the Export tab. 

Step 5: Export to File 

Choose a location and name for the file you are going to export to. The file 
normally has a .jbs extension. Once you have chosen a file, click Finish, and the 
data will be exported. 

Once Print Audit creates the exported file you can move it and copy it like any 
other file. You can e-mail it to someone, upload it to an FTP site, or copy it to 
another computer on your network. 

Setting up Scheduled Exports 

To set up scheduled imports, the wizard guides you through the following 5 
steps. Please note that there are additional requirements to set scheduled 
imports and exports. 

Step 1: Start 

Select Setup Scheduled Exports and click Next. The wizard moves to the 
Database tab. 

Step 2: Export From Database 

Review the currently selected database. The Wizard exports the jobs from this 
database. If you want to export data from a different database, click Change 
Database. Once you are satisfied with your database selection click Next. The 
wizard moves to the Export Settings tab. 

Step 3: Job Export Settings 

Click Export Jobs Only to export only job data from the database or click 
Export Jobs and Custom Fields to export job and custom field information. 

Click Export New Jobs to export jobs printed since the last time you exported 
jobs or click Export All Jobs in Database to export all of the jobs. 

Once you have made your choices, click Next. The wizard moves to the Merge 
codes tab. 
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Step 4: Merge Codes 

You use this tab to add or update the merge codes. The Job Wizard uses merge 
codes to properly match jobs with companies and to match custom fields.  

You must specify a merge code for the jobs you export. When these jobs are 
exported this merge code matches to one entered on the import side. 

If you are including custom field values in your export, set up merge codes for the 
custom fields you wish to export. Double click on the Custom Field Merge Codes 
grid to the right of the custom field name to enter in a merge code. 

If you leave the merge code for a field blank, it will not be exported. 

Once you enter the merge codes click Next. The wizard moves to the Export tab. 

Step 5: Job Export Schedule 

Set up either a daily, weekly, or monthly import schedule using the controls at the 
top of the tab. Enter a Print Audit PIN code that has Print Audit Administration 
privileges. Finally select the directory that contains the directory to export to. 

Every time the schedule executes Print Audit exports the jobs to the directory you 
specify. The new job file name corresponds to the date and time Print Audit 
exported the data. 

When you are satisfied with your schedule, click the Finish button. At this time 
Print Audit confirms your PIN code and saves the schedule. If your PIN code is 
incorrect, you will be prompted to change it 
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Print Audit 6 Database Maintenance Tool 

 
 

Welcome 

Welcome to the Print Audit 6 Database Maintenance Tool. This tool allows you to 
perform routine maintenance on your Print Audit database. It leads you through 
each task in an easy to use wizard style interface so you can quickly perform 
each task, even if you know nothing about databases. 

The tool presents you with different options depending on whether you are using 
a Microsoft Access or Microsoft SQL Server database as a back-end. You chose 
which one you wanted to use when you installed Print Audit. The tool 
automatically detects which version you installed and displays the appropriate 
screens. 

Thank you for using Print Audit. 
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Access Maintenance 

Microsoft Access Overview 

Microsoft Access is Print Audit’s default database. Print Audit uses a database 
to store all configuration and print job information. 
We highly recommend that you use this tool on a scheduled basis to compact 
your database. Regularly scheduled compacting of the database greatly 
reduces the risk of database corruption and other issues. It also decreases the 
size of your database and speeds up database operations. 

 
The following is a list of the tasks you can accomplish using this tool against a 
Microsoft Access database. 

 
 Compacting your Print Audit Database  
 Changing the Read-Only Database Password 

Compacting your Print Audit Database 

Compacting your Print Audit database is critical to long-term trouble free 
operation of Print Audit. Print Audit uses Microsoft Access as its database by 
default. The benefits of using a Microsoft Access database are that it is free, 
easy to backup and easy to install. The downside is that it requires periodic 
maintenance to ensure trouble free operation, and it does not perform well in 
large environments. You perform this periodic maintenance through 
compacting. 
Compacting does several technical things to your database, but the most 
important thing from your perspective is that it reduces the size of the database, 
increases the speed of data access and reduces the chance of database 
corruption. 
Print Audit provides two methods of compacting the database. The first is to use 
the wizard screens to go through and compact. The second is to compact the 
database from a DOS command-line. The second method allows you to create 
a batch file that you can then schedule to automatically compact the database 
periodically. 

  
To compact the database using the wizard: 
 

1. Start the Print Audit Database Maintenance tool. The tool starts on the 
Select Database Task screen. 

2. Click the Compact your Database option. 
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3. Click the Next button. The wizard moves to the Select your Print Audit 
Database screen. 

4. Enter the Print Audit database you want to compact. The wizard detects 
what the current database is on this computer. If you want to pick a 
different database, either type the full path to the database in or select it 
using the browse button. 

5. Click the Next button. The wizard moves to the Ready to Compact 
screen and gives you a chance to go back and change things before 
you compact. 

6. Click the Next button. The wizard starts to compact your database. 
When finished, it moves to the Finished screen and you are done. 

 
To compact the database from the command line: 

 
1. Ensure that no one is running the Print Audit Administration or Job 

Manager programs. These “lock” the database. If locked you cannot 
compact. The Print Audit Client only locks the database if writing a print 
job so you should not need to shutdown every client. 

2. Start an MS-DOS session. 
3. Type the full path to the database maintenance tool, followed by a 

space, /c, another space and the full path to the database you want to 
compact. If you do not include the path to the database then Print Audit 
compacts the currently setup database. 

4. Press the Enter key. Print Audit compacts the database. 
 

For example, if you could type the following (X corresponds to the drive where 
you placed the database): 
c:\program files\print audit inc\print audit 6\admin\pa6dbmnt.exe /c 
X:\printaudit.mdb 
 
You can use this method of compacting within a batch file that you can 
schedule to run periodically from any number of scheduling tools. 

Select the Database Task 

This part of the wizard allows you to select which task you want to perform on 
your Print Audit database. The options are as follows: 
Compact your database – Click this option to compact your Print Audit 
database. Compacting your database reduces size, increases speed and 
reduces the risk of corruption. Also choose this option if your database has 
become corrupted and Print Audit will attempt to repair it. 
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Change the read-only password – Click this option to change the password for 
the PAReadOnly account. Every Print Audit database has this account with a 
default password of “password”. If you are concerned about security you should 
change this password. 

Select your Print Audit Database 

This part of the wizard allows you to select the Print Audit database on which 
you want to perform the task you selected. Print Audit automatically chooses 
the Print Audit database set on this computer. If Print Audit could not find a 
database, the box is blank. 
This screen displays the following information: 
 

 Database – Use this box to type in the path to the database on which 
you want to perform the task. You can also click the Open button to the 
right of the box to bring up a standard Windows browse dialog so you 
can search for the database you want. 

 
Click the Next button when you are done to move on to the next screen. 

Ready to Compact 

This part of the wizard allows you to start compacting your database. If you are 
not sure you want to compact the database you selected on the previous 
screen, click Back to select a different one. 
 
As you compact, the status of the operation displays in the rectangular box. 
 
Click the Compact button when you are ready to start the compacting process. 

 

Changing the Read-Only Password 

Changing the Read-Only Database Password 

For your convenience Print Audit provides a read-only login into your Print Audit 
database so you can use third party programs to access your data. For example 
you may need to take the print job data and bring it in to another database in 
your organization for proper accounting. 
Print Audit gives you this functionality through a Microsoft Access database 
account called “PAReadOnly”. When you install a new Print Audit database the 
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password for this account is “password”. We highly recommend you change this 
password if you have any concerns about someone using tools other than Print 
Audit to view your data. 

 
To change the read-only password: 

 
1. Start the Print Audit Database Maintenance tool. The tool starts on the 

Select Database Task screen. 
2. Click the Change the read-only password option. 
3. Click the Next button. The wizard moves to the Select your Print Audit 

Database screen. 
4. Enter the Print Audit database you want to change. The wizard detects 

what the current database is on this computer. If you want to pick a 
different database, either type the full path to the database in or select it 
using the browse button. 

5. Click the Next button. The wizard moves to the Change your Print 
Audit Read-Only Password screen. 

6. Type in your old password, new password and new password again to 
confirm. Please note that if this is the first time you are changing the 
password, the value you should enter in the Old Password box is 
“password”. 

7. Click the Change button. Print Audit changes the password and moves 
to the Finish screen. Please store the new password in a safe place. If 
you lose it there is no way to recover it. 

Select the Database Task 

This part of the wizard allows you to select which task you want to perform on 
your Print Audit database. The options are as follows: 
 

 Compact your database – Click this option to compact your Print Audit 
database. Compacting your database reduces size, increases speed and 
reduces the risk of corruption. Also choose this option if your database 
has become corrupted and Print Audit will attempt to repair it. 

 Change the read-only password – Click this option to change the 
password for the PAReadOnly account. Every Print Audit database has 
this account with a default password of “password”. If you are concerned 
about security you should change this password. 
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Change your Print Audit Read-Only Password 

This part of the wizard allows you to enter your old and new Print Audit read-
only passwords. Please remember to store the new password you enter in a 
safe place. If you lose the new password you will not be able to access the 
PAReadOnly account for your database. 

 
This screen displays the following information: 
 

 Old password – Please enter your existing read-only account password 
here. If you have never changed the password before, the password is 
“password”. 

 New password – Please enter your new password in this box. Do not 
forget this password. 

 Confirm password – Please re-enter the password you put in the New 
password box here. This is just to ensure you entered the password you 
want. 

 
Click the Change button to change the password. 

SQL Server Maintenance 

Microsoft SQL Server Overview 

Print Audit 6 fully supports Microsoft SQL Server as a back-end database. Print 
Audit uses this database to store configuration information as well as print job 
information. 
This SQL Maintenance tool provides you with simple SQL Server maintenance 
functionality. 
The following is a list of the SQL Server tasks you can accomplish with this tool: 

 Creating a Print Audit Database  
 Changing the Print Audit Login Password  
 Changing the System Administrator Login Password 
 Running a SQL Script 
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Creating a New Database 

Creating a Print Audit Database 

The main reason to use the Print Audit Database Maintenance tool is to create 
a new Print Audit database on the SQL Server. The wizard leads you through 
the steps to creating the database. If you need specific information about each 
of the wizard screens, click the Help button at the bottom left of every wizard 
screen. Below is a general description of how to use the wizard to create a new 
Print Audit database. 

 
To create a Print Audit database: 
 

1. Start the Print Audit SQL Server Maintenance tool. The wizard starts on 
the Enter SQL Server Login Information screen. 

2. Enter the old SQL Server administration login password and click the 
Next button. The Select the SQL Server Task screen appears. 

3. Click the Create a new database option. 
4. Click the Next button. The Enter the Print Audit Database screen 

appears. 
5. Enter the name of the new Print Audit database name in the text box or 

you can just use the default. 
6. Click the Next button. If the Print Audit SQL Server login already exists 

the Ready to Create screen appears, otherwise the Enter the Print 
Audit Login Password screen appears. If the Ready to Create screen 
appears, skip to step 9. 

7. Enter the new the Print Audit login password. 
8. Click the Next button. The Ready to Create screen appears. 
9. Review the information on the Ready to Create screen. 
10. Click the Create button to start creating the new Print Audit database. 

The SQL Maintenance tool starts to create the database. This can take 
a couple of minutes. 

11. If Print Audit detects that it is necessary to change the SQL 
administrator (sa) password, the Changing the System Administrator 
Login Password screen appears. Otherwise you are done. 

 

Enter SQL Server Login Information 

This part of the wizard requires you to enter your SQL Server login information. 
Print Audit uses this information to connect to the SQL Server so it can perform 
operations on the Print Audit database. 
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This login must have the appropriate permissions to create and modify 
databases and logins. 

 
The wizard screen contains the following fields: 

 
 Server – Please type the name of the SQL server to which you want to 

connect. This field defaults to “(local)” which means the SQL Server 
installed on the computer you are using. If you know the name of 
another server that you want to install the Print Audit database on, 
please enter that information here. 

 Login – Please enter the login name for a SQL Server login that has 
system administrator privileges. This is typically the “sa” account. 

 Password – Please enter the password for the SQL Server login you 
specified above. 

 Use Windows authentication – Check this box if your SQL Server is 
setup to allow Windows authentication only. This option disables the 
Login and Password boxes and uses your Windows login and 
password to attempt connection to the database. 

 Network Provider – You may need to enter an alternative SQL Server 
network library dll name in this box if you have troubles connecting to 
the SQL database. If blank, it uses the default network library as 
defined on the system. The name you enter here must be the name of 
the dll minus the extension and the path to the dll. So for example if you 
want to force Print Audit to use SQL Server’s TCP/IP connectivity, you 
would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced 
SQL Server installations only. 

 
Click the Next button when you are ready to move to the next step. If Print Audit 
cannot find the server, or the login and passwords are incorrect, an error 
message will display. You must enter the proper information before you can 
continue 

Enter the Print Audit Database Name 

Use this part of the wizard to enter the name for the Print Audit database. You 
can name this anything you want or just accept the default. 
 
If a database with the same name already exists on the server the wizard warns 
you and allows you to choose if you want to overwrite it. If you decide you want 
to overwrite it all of the old information will be lost. 
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Please remember the name you enter here, as you may need to enter it into 
Print Audit when you connect to the database for the first time. 
 
The wizard screen contains the following fields: 
 

 Database – Enter the name of the new Print Audit database here. You 
can also leave the default. 

 
Click the Next button to move to the next step of the wizard. 

Enter the Print Audit Login Password 

This part of the wizard asks you to enter the Print Audit login password. By 
default the Database Maintenance tool creates a login account called 
“PrintAudit” on the SQL Server. This is the account that the other products in 
the Print Audit suite use to connect to your database. 

  
NOTE: You only get this wizard screen while creating a database if the 
"PrintAudit" login account does not already exist on the server. 
 
The fields on this screen are: 
 

 Name – This field displays the login name for the Print Audit login 
account. You cannot change this value. 

 Password – This field allows you to enter a password for the Print Audit 
login account. All Print Audit applications will use this password to 
connect to your database. You may want to keep this password private if 
you are worried about users going into the database using means other 
than Print Audit. 

 
Click the Next button to move on to the next part of the installation. 

Ready to Create 

This part of the wizard provides you with a checkpoint to confirm all of the 
information you have entered so far. You should write this information down 
somewhere, as you may need it later to connect to the Print Audit database. 
If the information on this screen is not correct, you must go back to the previous 
wizard screens to change it. 
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This screen displays the following information: 
 

 Server – This is the server name that the wizard is going to create the 
new database on. You entered this server name on the first screen of the 
wizard. A value of “(local)” means that the wizard will create the database 
on the SQL server installed on this computer. 

 Database – This is the name of the database the wizard will create. If 
“(Overwrite)” is appended to the database name it means that the wizard 
will replace any existing database with the same name. 

 Login – This is the name of the Print Audit database login account. This 
login name cannot be changed. Print Audit will use this login name to 
connect to the database. 

 Password – This is the password for the Print Audit login account. A 
value of “<Password previously set>” for the password means that the 
Print Audit login account already exists on the SQL Server and will not be 
changed. 

 
Click the Create button to have the Print Audit wizard create the database. 
Click the Back button to go back in the wizard and change any information that 
is incorrect. 

Change the System Administrator Password 

This part of the wizard allows you to change the SQL Server “sa” login 
password. The “sa” account is the main SQL Server account. If you leave it 
open and unsecured anyone with SQL tools can access and change your 
server. 
NOTE: You only get to this screen while creating a new database if the initial 
login account was “sa” and the password was blank. 
 
The fields on this screen are: 

 
 New password – Enter the new password for the “sa” login. Please 

record this password somewhere. If you forget the password you will 
have to reinstall the SQL Server. 

 
     Click the Change button to change the password. 
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Finished Using the Wizard 

This part of the wizard displays a summary of the task you just accomplished. 
Congratulations! 
Click the Done button to exit the wizard. 

Changing the Print Audit Login Password 
 

Changing the Print Audit Login Password 

You can use the Print Audit Database Maintenance tool to change the Print 
Audit login password. This is the password that all Print Audit users use to 
connect to the database. 

 
To change the Print Audit login password: 

 
1. Start the Print Audit Database Maintenance tool. The wizard starts on 

the Enter SQL Server Login Information screen. 
2. Enter the SQL Server administration login password and click the Next 

button. The Select the SQL Server Task screen appears. 
3. Click the Change the Print Audit User Password option. 
4. Click the Next button. The Change the Print Audit User Password 

screen appears. 
5. Enter the new password for the Print Audit user login. 
6. Click the Change button to change the password. 

Enter SQL Server Login Information 

This part of the wizard requires you to enter your SQL Server login information. 
Print Audit uses this information to connect to the SQL Server so it can perform 
operations on the Print Audit database. 
This login must have the appropriate permissions to create and modify 
databases and logins. 

 
The wizard screen contains the following fields: 

 
 Server – Please type the name of the SQL server to which you want to 

connect. This field defaults to “(local)” which means the SQL Server 
installed on the computer you are using. If you know the name of 



 

 

107 

another server that you want to install the Print Audit database on, 
please enter that information here. 

 Login – Please enter the login name for a SQL Server login that has 
system administrator privileges. This is typically the “sa” account. 

 Password – Please enter the password for the SQL Server login you 
specified above. 

 Use Windows authentication – Check this box if your SQL Server is 
setup to allow Windows authentication only. This option disables the 
Login and Password boxes and uses your Windows login and 
password to attempt connection to the database. 

 Network Provider – You may need to enter an alternative SQL Server 
network library dll name in this box if you have troubles connecting to 
the SQL database. If blank, it uses the default network library as 
defined on the system. The name you enter here must be the name of 
the dll minus the extension and the path to the dll. So for example if you 
want to force Print Audit to use SQL Server’s TCP/IP connectivity, you 
would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced 
SQL Server installations only. 

 
Click the Next button when you are ready to move to the next step. If Print Audit 
cannot find the server or the login and passwords are incorrect an error 
message will display. You must enter the proper information before you can 
continue. 

Change the Print Audit User Password 

This part of the wizard allows you to change the Print Audit login password. This 
is the account that the other products in the Print Audit suite use to connect to 
your database. You only need to change the password if you have forgotten the 
old one or if you are concerned about security. 
 
The fields on this screen are: 

 
 Name – This field displays the login name for the Print Audit login 

account. You cannot change this value. 
 New password – Enter the new password for the Print Audit login 

account here. Please note that everyone using Print Audit tools will now 
have to use this new password to get into your database. 

 
Click the Change button to change the password. 
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Finished Using the Wizard 

This part of the wizard displays a summary of the task you just accomplished. 
Congratulations! 
Click the Done button to exit the wizard. 
 

Changing the System Administrator Password 

Changing the System Administrator Login Password 

  You can use the Print Audit Database Maintenance tool to change the system 
administrator login password. This is the password for the SQL Server “sa” 
account. This is a special account in SQL Server that has full power to change 
anything on a SQL Server. This password is blank by default when you install 
SQL Server, so you want to change it as soon as possible. 

 
To change the system administrator login password: 

 
1. Start the Print Audit Database Maintenance tool. The wizard starts on 

the Enter SQL Server Login Information screen. 
2. Enter the old SQL Server administration login password and click the 

Next button. The Select the SQL Server Task screen appears. 
3. Click the Change the system administrator (sa) password option. 
4. Click the Next button. The Change the System Administrator Password 

screen appears. 
5. Enter the new password for the system administrator. 
6. Click the Change button to change the password. 
 

NOTE: The wizard also allows you to change the system administrator 
password at the end of the Create Database process. 

Enter SQL Server Login Information 

This part of the wizard requires you to enter your SQL Server login information. 
Print Audit uses this information to connect to the SQL Server so it can perform 
operations on the Print Audit database. 
This login must have the appropriate permissions to create and modify 
databases and logins. 
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The wizard screen contains the following fields: 
 

 Server – Please type the name of the SQL server to which you want to 
connect. This field defaults to “(local)” which means the SQL Server 
installed on the computer you are using. If you know the name of 
another server that you want to install the Print Audit database on, 
please enter that information here. 

 Login – Please enter the login name for a SQL Server login that has 
system administrator privileges. This is typically the “sa” account. 

 Password – Please enter the password for the SQL Server login you 
specified above. 

 Use Windows authentication – Check this box if your SQL Server is 
setup to allow Windows authentication only. This option disables the 
Login and Password boxes and uses your Windows login and 
password to attempt connection to the database. 

 Network Provider – You may need to enter an alternative SQL Server 
network library dll name in this box if you have troubles connecting to 
the SQL database. If blank, it uses the default network library as 
defined on the system. The name you enter here must be the name of 
the dll minus the extension and the path to the dll. So for example if you 
want to force Print Audit to use SQL Server’s TCP/IP connectivity, you 
would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced 
SQL Server installations only. 

 
Click the Next button when you are ready to move to the next step. If Print Audit 
cannot find the server or the login and passwords are incorrect an error 
message will display. You must enter the proper information before you can 
continue. 

Change the System Administrator Password 

This part of the wizard allows you to change the SQL Server “sa” login 
password. The “sa” account is the main SQL Server account. If you leave it 
open and unsecured anyone with SQL tools can access and change your 
server. 
NOTE: You only get to this screen while creating a new database if the initial 
login account was “sa” and the password was blank. 
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The fields on this screen are: 
 

 New password – Enter the new password for the “sa” login. Please 
record this password somewhere. If you forget the password you will 
have to reinstall the SQL Server. 

 
Click the Change button to change the password. 

Finished Using the Wizard 

This part of the wizard displays a summary of the task you just accomplished. 
Congratulations! 
Click the Done button to exit the wizard. 

Running a SQL Script 

Running a SQL Script 

You can use the Print Audit Database Maintenance tool to run any sql script 
against the Print Audit database. You may need to run scripts to repair 
accidentally damaged databases, or to perform different database maintenance 
tasks.  
NOTE: Print Audit is not responsible for any damage or loss of data that occurs 
when running scripts against your database that you have not received directly 
from Print Audit. You should only use this functionality if Print Audit directs you 
to, or if you are an advanced SQL user. 
 
To run a sql script: 

 
1. Start the Print Audit Database Maintenance tool. The wizard starts on 

the Enter SQL Server Login Information screen. 
2. Enter the SQL Server administration login password and click the Next 

button. The Select the SQL Server Task screen appears. 
3. Click the Run a sql script file option. 
4. Click the Next button. The Enter the Print Audit Database Name 

screen appears. 
5. Enter the name of the Print Audit database you want to run the script 

against. 
6. Click the Next button. The Select a SQL Script File screen appears. 
7. Type the path to the script file, or click the Browse button to open a 

standard dialog so you can look for the file. 
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8. Click the Run button to run the script. After the script has completed the 
Summary screen appears. 

Enter SQL Server Login Information 

This part of the wizard requires you to enter your SQL Server login information. 
Print Audit uses this information to connect to the SQL Server so it can perform 
operations on the Print Audit database. 
This login must have the appropriate permissions to create and modify 
databases and logins. 
 
The wizard screen contains the following fields: 

 
 Server – Please type the name of the SQL server to which you want to 

connect. This field defaults to “(local)” which means the SQL Server 
installed on the computer you are using. If you know the name of 
another server that you want to install the Print Audit database on, 
please enter that information here. 

 Login – Please enter the login name for a SQL Server login that has 
system administrator privileges. This is typically the “sa” account. 

 Password – Please enter the password for the SQL Server login you 
specified above. 

 Use Windows authentication – Check this box if your SQL Server is 
setup to allow Windows authentication only. This option disables the 
Login and Password boxes and uses your Windows login and 
password to attempt connection to the database. 

 Network Provider – You may need to enter an alternative SQL Server 
network library dll name in this box if you have troubles connecting to 
the SQL database. If blank, it uses the default network library as 
defined on the system. The name you enter here must be the name of 
the dll minus the extension and the path to the dll. So for example if you 
want to force Print Audit to use SQL Server’s TCP/IP connectivity, you 
would enter DBMSSOCN or DBNETLIB. NOTE: This is for advanced 
SQL Server installations only. 

 
Click the Next button when you are ready to move to the next step. If Print Audit 
cannot find the server or the login and passwords are incorrect an error 
message will display. You must enter the proper information before you can 
continue. 
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Enter the Print Audit Database Name 

Use this part of the wizard to enter the name of the Print Audit database you 
want to run the script against. 
If the database does not exist, Print Audit does not allow you to continue. 
The wizard screen contains the following fields: 
 

 Database – Enter the name of the Print Audit database here. 
 

Click the Next button to move to the next step of the wizard. 

   Select a SQL Script File 

This part of the wizard allows you to select the SQL script file you want to run 
against the database. Please note that Print Audit is not responsible for any loss 
of or damage to your Print Audit data when running a script not approved by 
Print Audit. You should not use this functionality unless Print Audit instructs you 
to or unless you are an advanced SQL user. 
This screen displays the following information: 

 
 Script – Type the full path and name of the sql script file you want to 

run here. You can also click the Browse button to open a standard 
Windows dialog so you can find the file you want to run. 

 
Click the Run button to run the script. 



 

 

113 

Print Audit 6 Database Migration Wizard 

 

 
 
 

Overview 

Welcome to the Print Audit Database Migration Wizard! This tool allows you to 
upgrade Print Audit 5 databases to Print Audit 6 databases, as well as migrate 
Print Audit 6 MSAccess databases to Microsoft's SQL Server. 

To migrate your database: 

1. Start the Print Audit Database Migration Wizard. The wizard starts on the 
Select the Migration Type screen. 

2. Choose the migration type. Click the Next button. 
3. Depending on the migration type, select either the MSAccess or SQL 

Server database to migrate from. Click the Next button. 
4. Depending on the migration type, select either the MSAccess or SQL 

Server database to migrate to. Click the Next button to continue. 
5. Select your job migration options. Click the Next button to continue. 
6. Start migrating the data. 
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Once the data migration has completed you can click the Close button to close 
the wizard. 

 

Print Audit 6 Client Status and Deployment Tool 

 
 

Welcome 

Welcome to the Print Audit Client Status/Deployment tool. This tool has four main 
uses: 

1. Query computers on a network and retrieve information about Print Audit 6 
client installations.  

2. Install or upgrade the Print Audit 6 Client on a collection of computers on 
the network.  

3. Un-install the Print Audit 6 Client from a collection of computers on the 
network.  

4. Change the Client Communicator location on a collection of computers on 
the network.  

This tool is not recommended for use with computers running Windows 95, 
Windows 98, or Windows ME. Windows 2000 or newer is recommended.  
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Usage Requirements 

Minimum Requirements 

You must have the Active Directory client extensions installed on a computer to 
use the Client Status/Deployment tool. The extensions are included with 
Windows 2000 and newer operating systems. Older operating systems are not 
supported. 

Note that only the computer running the Client Status/Deployment tool needs the 
Active Directory extensions. Status information and installs can run on computers 
without the Active Directory extensions. 

 Requirements for gathering status information from a network 

There are no additional software requirements for using the Client Status / 
Deployment Tool to gather information about Print Audit 6 client installations on 
the network. 

Permissions 

To effectively gather status information, you must have the appropriate 
permissions on the network. The required permissions depend on your network 
configuration. In general, you need enough permissions to browse computers on 
the network. 

Requirements for pushing the Print Audit 6 client installation to computers 
on a network 

The Client Status / Deployment Tool can only push client installations to (or 
remotely un-install the Print Audit 6 client from) computers running Windows 
2000 or newer operating systems. Depending on how Vista or other operating 
systems have been secured, remote push installs may not be allowed. 

Permissions 

In order to install, upgrade, or uninstall Print Audit 6 on network computers, you 
must meet the following requirements: 

1. Target workstations must have Administrative shares enabled. 
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2. You must have permissions to use the Administrative shares on the target 
workstations. 

3. You must not be running any firewall software that blocks Windows file 
sharing or remote procedure calls (RPC) on the target computer. 

Using the Tool 

Querying Client Status 

You can use the Client Status / Deployment Tool to query a network and return 
information about Print Audit installations. 

   To query a domain: 

1. Select Domain / Open from the menu, or click the left-most button in the 
toolbar. The Open Domain dialog appears.  

2. Enter in the name of the domain or workgroup you want to query.  
3. Enter the name of the OU if you want to restrict the query to a single OU. 

If you have nested OUs you can separate the OUs with slashes. For 
example: TopLevelOU/SubOU/InnermostOU.  

4. Enter a partial computer name to filter the results by computer name. Print 
Audit only returns computers that contain the partial name.  

5. Click the OK button. Results start displaying immediately but it may take 
some time to find all computers in your organization.  

 When you query the network Print Audit returns the computer name and 
operating system. If the Print Audit Client is installed on a computer the 
following information also displays: 

1. The version of the Print Audit Client.  
2. The current Print Audit user (if any).  
3. The last time that computer printed. 
4. The first time the Print Audit client was ever seen running by the push 

install / status tool. 
5. The most recent time the Print Audit client was seen running. 
6. The location of the Client Communicator the Client is connected to. Note 

that this does not show up for older Clients.  

If no information about the Print Audit Client is shown for a computer it is usually 
caused by one of the following three conditions: 
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1. The Print Audit client is not installed on that computer.  
2. The Print Audit client is installed, but is not currently running (possibly 

because nobody is logged into that computer).  
3. An older version of the Print Audit Client is installed.  
4. Firewall software or hardware is blocking the communication to the Print 

Audit client.  

You may save the current status by clicking Domain / Save Report in the menu, 
or clicking the second button from the left in the toolbar. 

Installing Print Audit 6 to Network Computers 

You can use the Client Status / Deployment Tool to push the installation or an 
upgrade of the Print Audit 5 Client to other computers on the network. Whether 
you are installing or upgrading, the process is the same. 

To install Print Audit 5 to the network: 

1. Query the network client status.  
2. Select the computers on which you want to install or upgrade the Print 

Audit 5 Client. You can use SHIFT-CLICK and CTRL-CLICK to select 
more than one computer. 

3. Click the Push->Install to Selected Computers menu item. The Select 
Package to Install dialog appears. 

4. Select or create an installation package.  
5. Click the Install button. A progress dialog appears showing the installation 

to the computers. 

IMPORTANT: You cannot use this tool to install the Client to Windows 95, 98 or 
ME computers. If you want to deploy the Client to these operating systems you 
must use another method such as login scripts. 

Removing Print Audit 6 from Network Computers 

You can use the Client Status / Deployment Tool to uninstall the Print Audit 
Client from other computers on the network. This is a very similar process to 
installing or upgrading the client on network computers. 

To uninstall Print Audit from network computers: 

1. Query the network client status.  
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2. Select the computers from which you want to uninstall the Print Audit 
Client. You can use SHIFT-CLICK and CTRL-CLICK to select more than 
one computer. 

3. Click the Push->Uninstall from Selected Computers menu item. The 
Select Package to Install dialog appears. 

4. Select the package you want to uninstall.  
5. Click the Uninstall button. A progress dialog appears showing the 

installation to the computers. 

Updating the Client Communicator Location 

You can use the Client Status/Deployment tool to remotely change the location 
the Print Audit Client uses for the Client Communicator. You may need to do this 
if you move the Client Communicator after installation of the software. 

To update the Client Communicator location: 

1. Query the network client status. Select the computers you want to re-
configure. You can use SHIFT-CLICK and CTRL-CLICK to select more than 
one computer. 

2. Click the Push->Change Client Communicator Location menu item. The 
Update Selected Computers dialog appears. 

3. Enter the new location and port number for the Client Communicator. 
4. Click the Update button. A progress dialog appears showing the update of 

the computers. 

Please note that the Print Audit Clients use the new Communicator location the 
next time someone prints from that computer. 

Working With Installation Packages 

Selecting a Package 

Click on the package name on the Select Package dialog. You need to select a 
package when installing, upgrading, or uninstalling the Print Audit Client on 
network computers. 
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Importing a Package 

If you used the Print Audit installer to create a network installation you can import 
this network installation as a package and use it with this tool to install, upgrade, 
or uninstall the Print Audit client.  

Click the Import... button, and browse for the package.ini file for the network 
installation. This is usually in the same directory as the network installer package 
that you created using the Print Audit installer. You can also choose the Client 
only install package which reduces the amount of network traffic for deployment 
as the client only installer is much smaller than the full installer. 

Once you locate the package.ini file, click Open to import the package. You can 
immediately select this package and use it. 

Creating a Package 

Generally, you will want to import packages as described above. In some cases, 
though, you may want to create a new package yourself. To create a new 
package, click the Add button in the Select Package dialog. The Create New 
Install Package window will appear. Fill in the settings as described below: 

1. Name - the name you want to use for this install package.  
2. Description - a description you want to use for this install package.  
3. Installer - the Setup (.exe) or Windows Installer (.msi) file you want to 

push to the clients.  
4. Notify Users when Installation Completes - Check this box to have a 

dialog box appear on the computer after the installation finishes. This 
dialog informs the user that the package successfully installed.  

5. Command Line Parameters - If the installer requires command line 
parameters, provide these here. MSI packages automatically get the 
appropriate command-line parameters for silent installation.  

When you are satisfied with the settings, click the OK button to create the 
installation package. You can immediately select and use this newly-created 
installation package.  

Editing a Package 

To edit an existing package, double-click on its name in the list of packages. You 
can change any of the settings you want. Click OK when you have finished, or 
Cancel if you do not want to save your changes. 
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For a description of all the fields, see the description for Creating a Package 
(above). 

Deleting a Package 

To delete a previously created installation package select it from the list in the 
Select Package dialog and click the Delete button. 
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